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Chapter Overview
•	 Welcome

•	 Introduction to Simple Western
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•	 Compass Software for Simple Western Platforms

•	 Simple Western Assays Compatible with Leo 

Chapter 1:  

Let’s Get Started
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Welcome
Congratulations on bringing the Bio-Techne® Leo™ platform into your lab! We welcome you as a new user and are excited 
to be a part of your work. This user guide will provide you with information on performing a Simple Western™ size assay 
and other useful operating and installation information. 

To help you get the most from your Leo platform, we’ve added some attention phrases to assist you through the user 
guide:

NOTE		  Points out useful information.

IMPORTANT	 Indicates information necessary for proper operation of Leo.

CAUTION	 Cautions you about potentially hazardous situations that could result in injury to you or  
		  damage to Leo.

!WARNING!	 Warns you that serious physical injury can result if the listed precautions are not followed.

Introduction to Simple Western
Bio-Techne Simple Western Technology simplifies and automates traditional western blot processes to deliver sensitive, 
quantitative data. Simple Western assays are hands-free capillary immunoassays that combine protein separation with 
immunoassay-based detection using conventional antibodies. 

Simple Western Size Assays
Simple Western fully automates your immunoassay including sample loading, protein separation, immunoprobing and 
labeling, washing, detection, and data analysis. Tiny amounts of sample are separated inside capillaries and cross-
linked to the capillary wall, removing the inherent variability of traditional Western blotting that occurs when proteins 
are transferred to a membrane. The system then performs blocking and wash buffer incubations before using just 
a few microliters of your primary antibody and conjugated secondary antibodies to detect target proteins using 
chemiluminescence detection. 

Simple Western assays are performed in a fully enclosed, controlled, and standardized system, delivering precise and 
quantitative data, high-throughput sample processing, and automated protein analysis. 
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Leo – A High-Throughput Simple Western System
Leo maximizes your throughput, performing size-based capillary immunoassays (Simple Western assays) for up to 
96 samples in just 3–5 hours. Just prepare your samples and antibodies, pipette them into a Simple Western Leo Sample 
Plate, load your Leo instrument, and push Start. Leo does the rest. You’ll get picogram-level sensitivity, built-in total 
protein normalization, and highly reproducible quantitative results with molecular weight characterization. 

Leo performs the following size-based Simple Western assays: 

•	 Chemiluminescence Immunoassay

•	 Chemiluminescence Immunoassay + Chemiluminescence Immunoassay using RePlex™

•	 Chemiluminescence Immunoassay + Total Protein Normalization using RePlex and Chemiluminescence Detection

The system runs up to four 25-capillary cartridges in parallel to boost the amount of data you can generate in one run. 
You have the flexibility to run just one, two, or three capillary cartridges depending on your throughput needs, or all four 
cartridges to maximize your data generation. 

To operate Leo, you’ll need the following:

•	 Leo Pre-filled Reagent Plate: The plates are ready-to-use and contain the wash buffer, and running buffer, separation 
and stacking matrix for the size range of your choice. You will need one Pre-filled Reagent Plate for every capillary 
cartridge used in the run. 

•	 Leo 25-capillary cartridge for size-based separation.

•	 Leo Sample Plate: Where you will pipet your denatured sample, biotinylated ladder, diluted primary antibody, 
secondary antibody, wash buffer, antibody diluent, and luminol/peroxide. The Sample Plate is also where you will 
pipette your RePlex Reagent mix and Total Protein reagents if you plan to reprobe or perform a Total Protein assay. 

See Chapter 4 “Operating Leo” for more information. 

Cartridge 
Holders

Pre-filled  
Reagent Plate 

Holders

Sample 
Plate 

Holder
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Compass Software for Simple Western Platforms
Compass™ for Simple Western Software is used to run Simple Western assays on your Leo instrument, monitor the run 
while in progress, and analyze resulting data. The software is available online at the Bio-Techne Instrument Software 
Download Center for installation on a separate workstation. 

Simple Western Assays Compatible with Leo 

Chemiluminescence Immunoassay
Precisely quantitate your protein of interest with as little as 3 µL of sample. Leo loads separation and stacking matrix for 
the size range of your choice from the Pre-filled Reagent Plates into the capillaries, followed by a denatured sample from 
the Sample Plate. Proteins are separated by size as they migrate through the stacking and separation matrix before the 
proteins are covalently bound to the capillary wall using proprietary, photoactivated capture chemistry. Primary antibodies 
that recognize your protein(s) of interest are incubated in the capillary followed by an HRP-conjugated secondary and 
luminol/peroxide. The chemiluminescent signal is detected and quantitated using Compass Software. 

C H E M I LU M I N E S C E N C E I M M U N OA S S AY WO R K F LOW:

 

Load Sample

Load Matrix

Separate

Immobilize

Quantitate Signal

Low MWHigh MW

Stacking Matrix Separation Matrix

 

Target X 1˚ Ab HRP-labeled 2˚ Ab

Electric Current

Immunoprobe

Size-Based Immunoassay
Chemiluminescence Detection 

https://www.bio-techne.com/resources/instrument-software-download-center
https://www.bio-techne.com/resources/instrument-software-download-center
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Chemiluminescence Immunoassay + Chemiluminescence Immunoassay 
using RePlex
Get more data from your samples with RePlex. When you RePlex on Leo, you perform a chemiluminescence assay in the 
first round of probing (Probe 1) before the RePlex Reagent mix removes the primary and secondary antibodies. You can 
then perform a second chemiluminescence immunoassay with another primary/secondary antibody set (Probe 2). 

C H E M I LU M I N E S C E N C E I M M U N OA S S AY + C H E M I LU M I N E S C E N C E I M M U N OA S S AY U S I N G R E P L E X 
WO R K F LOW:

 

Load Matrix and Sample

Detect and Quantitate Target Y

Target YTarget X

 

Target Y Immunoprobe

Separate and Immobilize
Electric Current

Target X 1˚ Ab Labeled 2˚ Ab

Target Y 1˚ Ab Labeled 2˚ Ab

Target X Immunoprobe

Detect and Quantitate Target X

RePlex (Remove 1° and 2° Antibodies)

RePlex™ Assay
with Jess™, Abby™, and Leo™ Systems

Low MWHigh MW
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Chemiluminescence Immunoassay + Total Protein Normalization using 
RePlex and Chemiluminescence Detection
The total protein assay, performed on Leo as part of a RePlex assay, detects all the proteins in your sample to 
help you normalize your chemiluminescence data. Sample preparation, separation, and immobilization between a 
chemiluminescence and total protein assay are the same. After immobilization, the Total Protein Biotin-Labeling Reagent 
attaches biotin to all the proteins in your sample. The biotin is detected using Total Protein Streptavidin-HRP and luminol/
peroxide to generate a chemiluminescent signal. 

Total protein normalization is a preferred method to normalize data compared to housekeeping proteins. Compass for SW 
Software automatically normalizes the data for you, simplifying your analysis. 

C H E M I LU M I N E S C E N C E I M M U N OA S S AY + TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G R E P L E X A N D 
C H E M I LU M I N E S C E N C E D E T E C T I O N WO R K F LOW:

Total Protein Normalization using
RePlex and Chemiluminescence detection

Separation MatrixTarget YTarget X

RePlex (Remove 1° and 2° Antibodies)

Quantitate Total Protein Signal

Streptavidin-HRP

Detect All Proteins

Load Matrix and Sample 

Separate and Immobilize
Electric Current

Target X 1˚ Ab Labeled 2˚ Ab

Target X Immunoprobe

Detect and Quantitate Target X

Low MWHigh MW
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•	 Introduction

•	 Space Requirements

•	 Physical Specifications

•	 Electrical Requirements

•	 Environmental Requirements

•	 Software and Computer Requirements

•	 General Guidelines and Information
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Introduction
This chapter will help you prepare the lab for your Leo system. Please have the space, electrical, and environmental 
requirements ready prior to installation.

!WARNING! 
Please wait for the ProteinSimple representative to unpack and install the Leo instrument. Don’t try to lift or unpack 
the instrument on your own – you could cause injury to yourself or damage to the system.

Space Requirements
You will need a lab bench or table without raised or rounded edges that can support 350 lbs (159 kg) and has enough 
space for both the Leo instrument and a computer. There should be sufficient clearance for both heat ventilation and to 
provide access if the instrument needs service. 

IMPORTANT:  
Leo needs a stable surface and must remain level to work properly. The lab bench or table can’t shift or wobble 
under heavy weight.  
 
The lab bench will need to be <3.3 ft. tall to be compatible with the lift tools used by the ProteinSimple 
representative during instrument installation.

R E C O M M E N D E D B E N C H TO P S PAC E R E Q U I R E M E N T S F O R L E O

Dimension Meters Feet

Width 1.0 3.3

Depth 1.0 3.2

Height 1.3 4.2
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Physical Specifications

Description Specification

Leo’s Dimensions (Door Closed) 0.75 m H x 0.70 m W x 0.73 m D 
(2.5’ H x 2.3’ W x 2.4’ D)

Leo’s Dimensions (Door Open) 0.75 m H x 0.77 m W x 1.5 m D  
(2.5’ H x 2.5’ W x 4.9’ D)

Leo’s Weight 136 kg (300 lbs)

Computer Workstation Dimensions

Monitor/CPU: 0.43 m H x 0.57 m W x 0.21 m D (17” 
H x 22.4” W x 8.3” D)

 
Keyboard: 0.03 m H x 0.43 m W x 0.13 m D 
(1” H x 17” W x 5” D)

 
Mouse: 0.04 m H x 0.06 m W x 0.11 m D 
(1.4” H x 2.4” W x 4.5” D)

Electrical Requirements
Leo requires a dedicated, grounded circuit capable of delivering the appropriate current and voltage for your country. The 
power requirements for selected regions are listed below:

Region Volts (AC) Frequency (Hz) Amps

US and Canada 120 60 5.0

Europe 230 50 2.6

Japan 100 50/60 6.0

In addition to the requirements listed above, we recommend the grounded circuits terminate at the receptacles, and 
receptacles must be located within 10 ft (3 m) of the instrument. 
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Environmental Requirements
Leo instruments should be operated at a consistent temperature in the lab. It will work best when conditions stay within 
these ranges:

Requirements Specification

Indoor or outdoor use For indoor use only

Operating temperature range 18–23 °C (64–73 °F)

Operating humidity range 20–60% relative, non-condensing

Altitude < 2000 m

Mains Supply Fluctuations +/- 10%

Over Voltage Category OVC II

Pollution Degree Pollution Degree 2

NOTE: Leo should not be placed in a location with direct exposure to sunlight or placed on a table with a piece of lab 
equipment that will induce vibrations during operation, like a centrifuge. 

Software and Computer Requirements
Leo systems come with a computer that has Compass for Simple Western Software pre-installed. The software is used to 
run assays and analyze resulting data. 

Compass Software can be installed in a separate workstation, such as your laptop computer, if you don’t want to analyze 
your data at the Leo workstation in the lab. The software is available on the Compass for Simple Western CD that comes 
with Leo instrument, and is available at the Bio-Techne Instrument Software Download Center.

Your computer must meet the minimum requirements listed below to run Compass Software and process data. 

Component Minimum Recommended

Operating system Windows 11

Processor Core i7 or better

Memory 16 GB

Free disk space 100 GB

USB Ports 2 (Mouse and Keyboard)

Ethernet Ports 2

https://www.bio-techne.com/resources/instrument-software-download-center
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General Guidelines and Information

Intended Use
Leo systems are for research use only. Not for use in diagnostic procedures. 

Lifting and Moving the System

!WARNING! 
Do not attempt to lift or move Leo by yourself. Contact ProteinSimple to arrange for a ProteinSimple representative 
to move the instrument for you.
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Leo Systems

Chapter Overview
•	 Instrument Overview

•	 External Components

•	 Internal Components
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Instrument Overview
Leo instrument hardware components are described in this chapter. 

External Components

System Door

Touch Pad to  
Open Door

Status Light

System Door
The door to the Leo instrument gives you access to the inside of the system to load the capillary cartridge(s), Pre-filled 
Reagent Plate(s), and Sample Plate. To open the door, make sure the status light is a steady blue, then press the orange 
touch pad. To close the door, push the door until you hear the door latch “click”. Leo will then pull the door close.

NOTE: The Leo system door must be closed before starting a run. 
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Status Lights
The LED on the Leo instrument front panel provides you with status updates. 

•	 Start-up (magenta): You’ve turned on the power and the instrument is warming up.

•	 Ready (steady blue): Leo is powered on and ready for use.

•	 Opening Door (long blue flash followed by blue pulses/blinks): The Leo door is opening.

•	 Running (pulsing/blinking blue): Leo is scanning cartridge and plate barcodes or running an assay.

•	 Trying to Open Door While Running (orange flash): The Leo door can’t open the door when the instrument is running.

•	 Temperature or Relative Humidity Warning When Idle (pulsing/blinking orange): The ambient or instrument chamber 
temperature, or relative humidity is outside of Leo’s operating range. The run can still be started, but a warning 
message will display in the run file and the data generated may be impacted. 

•	 Error (steady red): Leo has detected an error. To get more information, check the Status window of the Run Summary 
Screen in Compass for Simple Western.

Status Light

NOTE: For more information about operating the instrument when there is a temperature or relative humidity 
warning, or it is in an error state, contact ProteinSimple Technical Support by phone at (888) 607-9692 or by email 
at support@bio-techne.com. For customers in Europe, please contact Technical Support at +44 1235 529449, or 
Instrument.Support.EMEA@bio-techne.com. You can also contact your local Field Application Scientist. 

mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
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Rear Panel
The power entry, power switch, and network connection port are located on the Leo instrument’s rear panel. 

System Power

DB9

HDMI

USB

Ethernet

•	 System Power - The main system power components consist of the power On/Off switch next to an AC power input 
port. 

•	 Connect to PC - A 10/100/BASE-T Ethernet (RJ-45 connector) is used to connect Leo to a computer.

!WARNING!  
Only use the power supply cord provided with Leo. If the cord is damaged, please contact ProteinSimple Technical 
Support toll-free in the US and Canada at 1-888-607-9692, and in Europe at +44 1235 529449. 

!WARNING! SHOCK HAZARD  
Disconnect the power cord from the power input to disconnect power to the instrument. 

The rear panel also includes a DB9 port, an HDMI port, and a USB 3.0 port. Do not connect cables to them as they should 
only be used by a ProteinSimple representative when the system is being serviced.

System Label 
A system label is also located on the Leo instrument’s rear panel. It includes the ProteinSimple location, system model, 
power requirements, serial number, and certification markings. 

NOTE: Serial numbers are used to identify individual instruments on the network. 
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Internal Components

Capillary Cartridge Holders
There are 4 capillary cartridge holders that will hold the Leo 25-Capillary Cartridge (P/N 009-651). White-lighted numbers 
on the cartridge holders indicate the position number, with Cartridge 1 positioned to the left and Cartridge 4 positioned to 
the right. 

NOTE:  
The 13-capillary Cartridge (P/N 009-081), Fluorescent Capillary Cartridge, 13x (P/N 009-400), 25-Capillary 
Cartridge (P/N 009-050), Fluorescence Capillary Cartridge, 25x (P/N 009-401), and Blot Cartridge (P/N 004-651) 
should not be used on Leo. 
 
Use only Leo-specific capillary cartridges (P/N 009-651) when performing Simple Western size assays on Leo. Jess 
and Abby capillary cartridges should not be used with Leo. 

Cartridge Shields
Cartridge shields appear above the cartridge holders and are not user-serviceable parts. 

Cartridge  
Shields

!WARNING!:  
Avoid touching the shields in general and when inserting capillary cartridges into the cartridge holders. 
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Pre-filled Reagent Plate Tray
The Pre-Filled Reagent Plate tray contains four plate holders. The Pre-filled Reagent Plates come with assay reagents for 
the size range you are running. 

Notch

A1 Position
Pre-filled 

Reagent Plate

A Pre-filled Reagent Plate holder has notches at the upper right and upper left corner that correspond to notches on 
the plate. Plates should be inserted into the plate trays so that the A1 position is aligned with the upper left corner of the 
holder. 

NOTES: 
Do not remove the seals from the Pre-filled Reagent Plate(s) until you are ready to load them into the instrument.  
 
Pre-filled Reagent Plate(s) should be inserted in Leo right before starting a run.  
 
When inserting Pre-filled Reagent Plate(s), make sure the plate is firmly seated and level in the tray. 
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Sample Plate Tray
The Sample Plate tray contains one plate holder that holds the Leo Sample Plate. The Sample Plate is where you will 
pipette your samples and immunoassay reagents. 

Sample Plate Tray 
Holder Protrusion

A1 Position

Sample Plate

The Sample Plate holder has a protrusion at the bottom center of the tray to ensure that a Pre-filled Reagent Plate is not 
accidentally placed in the Sample Plate tray. The plate should be inserted into the holder so that the A1 position is aligned 
with the upper left corner of the holder. 

NOTES:  
When inserting the Sample Plate, make sure the plate is firmly seated and level in the tray.  
 
The Sample Plate bottom notch should be flush with the small protrusion in the Sample Plate holder. 
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Inner Door Liner
Avoid touching the Leo inner door liner to keep it clean from debris and fingerprints. See “Maintenance” on page 103 for 
more information on cleaning the door liner. 

Door Liner
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Operating Leo

Chapter Overview
•	 Before You Throw the Switch

•	 Power Up

•	 Self Test

•	 Starting a Run

•	 Stopping a Run

•	 Viewing and Changing System Properties

•	 Viewing Errors and Test Logs

•	 Status Modes 

•	 Shutdown 



26

Chapter 4: Operating Leo   //  Before You Throw the Switch

User Guide for Leo

Before You Throw the Switch
Ensure that everyone using Leo has:

•	 Received instruction in general safety practices for laboratories. 

•	 Received instruction in specific safety practices for Leo. 

•	 Received instruction on handling of biohazards (if biohazardous materials are to be used on Leo).

•	 Read and understood all related Product Inserts and related Safety Data Sheets (SDS) documentation. 

•	 Completed in-person or virtual training provided by ProteinSimple.

•	 Review door opening/closing instructions. 

•	 Visited the Bio-Techne Training Academy and completed the Leo Learning Plan.

Power Up

NOTE: Turn the Leo system on with the door closed for at least 1.5 hours before starting a run to ensure the 
instrument reaches its temperature setpoint. 

1.	 Turn on the computer connected to Leo.

2.	 Turn on the main power switch located on the right rear panel. 

3.	 Wait for Leo to initialize. The status light will turn solid blue when the instrument is ready. 

4.	 Double-click the Compass for Simple Western icon to open the application. 

5.	 Connect Compass Software to Leo. 

a.	 Select Instrument in the main menu and click Connect…. Then select your Leo instrument and click Connect. 

b.	 If you don’t see your instrument, click on the Advanced Connect button in the bottom left corner of the Connect 
window. Type in the network address for your instrument and click Connect.

https://academy.bio-techne.com/learn/signin
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c.	 The instrument status bar will appear after Compass for Simple Western Software is connected to Leo. 

Self Test
Leo can perform a set of self-tests to make sure the instrument is operating properly. To start the testing, ensure all Leo 
cartridges, Pre-filled Reagent Plates, and the Sample Plate are removed from the instrument. Ensure Compass Software 
is connected to the system and then select Instrument in the main menu and click Self Test. A prompt will appear for 
confirmation to start the test. Click OK. Testing will take about 20 minutes. 

NOTE: We recommend running the self test monthly or when encountering issues with the system. When 
performing the self test, start the test before preparing your sample, reagents, and Sample Plate, and before peeling 
the two seals off the Pre-filled Reagent Plate(s). 

To view the log when the test is done, select Instrument in the main menu, click Properties, and click Logs.
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Select the test log you would like to view and click View. 

To export and save self test results, click Report. 



29

Chapter 4: Operating Leo   //  Starting a Run

User Guide for Leo

Select the number of self tests to download and the details to include. Click OK to save the self test report(s) to the 
designated file directory. 

Starting a Run

NOTES:  
Turn the Leo system on with the door closed for at least 1.5 hours before starting a run to ensure the instrument 
reaches its temperature setpoint. 
 
Keep the Leo door closed when the cartridge holders and plate trays are not being accessed to keep the instrument 
chamber temperature at the optimal operating range.

To start a run after loading the 25-Capillary Cartridge(s), Pre-filled Reagent Plate(s), and prepared Sample Plate in the Leo 
system, click the Start button on the Assay screen. You can also start a run by selecting Instrument in the main menu and 
clicking Start. 

For more information on setting up a run, including sample and reagent preparation, refer to Chapter 5: “Running 
Chemiluminescence Assays”
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Stopping a Run
To stop a run, click Stop. 

A prompt will appear asking if you really want to stop the run. Click Yes. 

When the run stops, the Start button will reappear, and the instrument will end the run as soon as possible.

When the run has stopped, you can remove the capillary cartridge(s), Pre-filled Reagent Plate(s), and the Sample Plate and 
discard them. The stopped status, date, and time will be displayed on the Run Summary screen. 

IMPORTANT: Do not re-use capillary cartridges or Pre-filled Reagent Plates. 

Viewing and Changing System Properties
From the Compass for Simple Western main menu, select Instrument and click Properties to see properties for Leo:

•	 Name

•	 Location

•	 Type

•	 Serial number

•	 Instrument software version (embedded)

•	 Network name and address

•	 Date and time of the instrument clock

•	 To change the system name or location: Click in the name or location box and enter the new information. 

•	 To sync the instrument clock with the computer: Click Set to PC time. 
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Viewing Errors and Test Logs
From the Compass for Simple Western main menu, select Instrument and click Properties. To view a log, click Logs. 

The table that displays shows the list of Self Test logs. You can also select Command Log or Instrument Log to view and 
save logs related to the instrument and software. 
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Status Modes 
The instrument status bar displays status, buttons, warnings, and progress bars depending on what Leo is doing. 

•	 Ready/Start button - Leo is ready and an assay is loaded. The status light will be solid blue. Click Start to begin a run. 

•	 Not Ready/Reset button – Leo is not ready and must reinitialize. The status light will be red or magenta. Click Reset to 
start the initialization protocol. 

•	 Running/Stop button - Leo is running an assay. The status light will be blinking blue. The run name, time it started, and 
when it will be done are shown in the run progress bar. Click Stop to stop the run. 

•	 Error/Reset button - Leo has detected an error. Go to the Status window in the Run Summary screen to get more 
details. The status light will be red. Once you’ve been able to correct the error, click Reset. 

NOTES:  
You will only see the instrument status bar when Compass for Simple Western is connected to an instrument. There 
is no status bar on computer workstations that you’re only using for data analysis. 
 
A warning message will appear in the instrument status bar if the ambient temperature, chamber temperature, or 
relative humidity is outside the optimal operating range. 

Shutdown 
1.	 Make sure to remove all plates and cartridges before shutting down the system. 

IMPORTANT: Liquid may leak out of the cartridge if left in the instrument after Leo is powered down.

2.	 Close Compass for Simple Western Software and shut down the computer connected to Leo. 

3.	 Leo should remain on unless you won’t use it for more than a week. In that case, you can just turn the power off.
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NOTE: Refer to the Compass for Simple Western User Guide to learn more about Compass Software features. 

Overview
Leo is an open platform, giving you flexibility in your Simple Western assay setup. 

Throughput

Leo can perform parallel immunoassays in 4 capillary cartridges to generate 100 data points in one run. When your assay 
throughput needs are lower, you can also just run 1 cartridge, 2 cartridges, or 3 cartridges in a run. 

Resampling Rows

Sample rows and antibody rows can be resampled, so that one sample row or one antibody row can be used to load 
multiple capillary cartridges in one run. This increases the number of data points you get per sample, increases your 
sample and/or antibody savings, and decreases the time it takes to set up a run.

Assay setup

You can choose from different validated assay combinations based on your experimental needs.

•	 Chemiluminescence Immunoassay: Perform a chemiluminescence immunoassay on 1-4 capillary cartridges. 
Generates up to 100 data points. 

•	 Chemiluminescence Immunoassay + Chemiluminescence Immunoassay using RePlex: Perform a 
chemiluminescence immunoassay on 1-4 capillary cartridges, then use the RePlex Reagent mix to remove antibodies 
from the first round of probing. Perform a second chemiluminescence immunoassay with a fresh set of antibodies in a 
second probe. Generates up to 200 data points. 

•	 Chemiluminescence Immunoassay + Total Protein Normalization using RePlex and Chemiluminescence Detection: 
Perform a chemiluminescence immunoassay on 1-4 capillary cartridges, then use the RePlex Reagent mix to remove 
antibodies from the first probe. Perform sequential protein normalization detecting total protein chemiluminescence 
signal in the same capillary. This method generates up to 100 total protein-normalized data points. 

NOTE: The Leo system should be on with the door closed for at least 1.5 hours before starting a run to ensure the 
instrument reaches its temperature setpoint. See “Power Up” on page 26 for instructions on turning on Leo. 

https://resources.bio-techne.com/bio-techne-assets/docs/software/Simple%20Western/CompassforSW_7.0.0/Compass%20SW%20Software%20User%20Guide.pdf
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Starting a Run

What you’ll need
•	 Leo Separation Module for the size range of your choice. 

•	 Simple Western 12–230 kDa Separation Module 

Components

Leo 25-Capillary Cartridges
Leo 12–230 kDa Pre-filled Reagent Plates
Leo Sample Plates
10X Sample Buffer
Wash Buffer
Plate Cover
EZ Standard Pack 1

Lyophilized, 12–230 kDa FL Standard  
w/ 29 kDa System Control

DTT

12–230 kDa EZ Biotinylated Ladder

•	 Simple Western 66–440 kDa Separation Module 

Components

Leo 25-Capillary Cartridges
Leo 66–440kDa Pre-filled Reagent Plates
Leo Sample Plates
10X Sample Buffer
Wash Buffer
Plate Cover
EZ Standard Pack 3

Lyophilized, 66–440 kDa FL Standard 
w/ 90 kDa System Control

DTT

66–440 kDa EZ Biotinylated Ladder

•	 Simple Western 2–40 kDa Separation Module 

Components

Leo 25-Capillary Cartridges
Leo 2–40 kDa Pre-filled Reagent Plates
Leo Sample Plates
10X Sample Buffer
Wash Buffer
Plate Cover
EZ Standard Pack 5

Lyophilized, 2–40 kDa FL Standard 
w/ 26 kDa System Control

DTT

2–40 kDa EZ Biotinylated Ladder

NOTES:  
Leo Pre-filled Reagent Plates are preloaded with 
separation matrix, stacking matrix, running buffer, 
matrix removal buffer, and wash buffer.  
 
Capillary Cartridge Kits, Pre-filled Reagent Plates 
and Reagent Kits for your size range of choice, 
EZ Standard Packs, and Sample Plate Kits are 
available as à la carte products as well. 
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•	 Leo Detection Module, Chemiluminescence

Components

Luminol-S
Peroxide
Streptavidin-HRP
Antibody Diluent 2 or Milk-Free Antibody Diluent
Secondary Antibody
And one of the following*: 
Gt Anti-Rabbit Secondary HRP Antibody
Gt Anti-Mouse Secondary HRP Antibody
Secondary Streptavidin HRP
Gt Anti-Human IgG Secondary HRP Antibody
Dk Anti-Goat Secondary HRP Antibody

*No secondary antibody is provided with the “No Secondary Detection Module”

NOTES:  
Use the Simple Western Kit Builder to identify the exact kits needed to perform your experiment.  
 
Jess and Abby Detection Modules are also compatible with Leo. 

•	 Bio-Techne RePlex Module, (optional)

•	 Bio-Techne Simple Western Total Protein Detection Module, (optional)

•	 Protein samples

•	 Primary antibodies

•	 System Control Primary Antibody (optional)

•	 Water, 0.22 µm-filtered and deionized (molecular biology grade or better)

•	 Pipettes and tips

•	 Microcentrifuge and tubes

•	 Ice and ice bucket

•	 Vortex

•	 Heat block/thermocycler/water bath

•	 Centrifuge with plate adaptor

NOTE: Visit the Simple Western Antibody Database to find commercial primary and secondary antibodies validated 
for Simple Western Technology. 

https://www.bio-techne.com/resources/simple-western-kit-builder
https://www.bio-techne.com/resources/simple-western-antibody-database
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1.	 Open the EZ standard pack and remove the tubes.

2.	 Prepare 400 mM DTT (clear tube). 
Prepare at least one tube per row of sample

a.	 Pierce the foil with a pipette tip.

b.	 Add 40 µL deionized water. 

c.	 Gently mix by pipetting up and down. 

d.	 If multiple tubes are prepared, combine the DTT into one microcentrifuge tube and gently mix by pipette to avoid 
creating bubbles. 

NOTE: If you want to run non-reduced samples on Leo, reach out to ProteinSimple Technical Support at (888) 
607-9692 or by email at support@bio-techne.com. For customers in Europe, please contact Technical Support 
at +44 1235 529449, or Instrument.Support.EMEA@bio-techne.com. You can also contact your local Field 
Application Scientist. 

3.	 Prepare the Fluorescent 5X Master Mix (pink tube). 
Prepare at least one tube per row of sample 

a.	 Pierce the foil with a pipette tip.

b.	 Add 20 µL 10x Sample Buffer.

c.	 Add 20 µL prepared 400 mM DTT solution.

d.	 Gently mix by pipetting up and down. 

e.	 If multiple tubes are prepared, combine the Fluorescent 5X Master Mix into one microcentrifuge tube and gently mix 
by pipette to avoid creating bubbles.

4.	 Prepare the Biotinylated Ladder (green tube with pink pellet). 
Prepare 1 tube per run

a.	 Pierce the foil with a pipette tip. 

b.	 Add 20 µL deionized water. 

c.	 Gently mix by pipetting up and down. 

mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
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Step 2: Prepare Your Samples

NOTES:  
Prepare enough sample to pipette 3 µL per well.  
 
The optimal protein concentration depends on your protein's expression level. Dilute lysates as necessary with 
0.1X Sample Buffer. For a new assay measuring endogenous protein levels, we recommend starting around a 
final concentration of 0.4 mg/mL. Refer to the Bio-Techne Academy for information on determining optimal lysate 
concentrations.  
 
Bicine/CHAPS lysis buffer (P/N 040-764) and RIPA lysis buffer (P/N 040-483) are optimized for use with Simple 
Western systems and can be used to lyse your cells. If you would prefer to use your own buffer, refer to the Simple 
Western Size Assay Buffer Compatibility Matrix to check for the compatibility of commonly used commercial 
buffers or buffer components with Simple Western systems. 

1.	 In a microcentrifuge tube, combine 1-part Fluorescent 5X Master Mix with 4-parts diluted lysate. 

2.	 Close the microcentrifuge tube.

3.	 Pipette or gently vortex the sample to mix thoroughly. 

4.	 Centrifuge the microcentrifuge tube and heat the sample in a water bath, heat block, or thermocycler at 95 °C for 
5 minutes.

NOTE: Some proteins may require other denaturation conditions. Denature your sample at the optimal temperature 
for your target of interest. 

5.	 Vortex the sample.

6.	 Spin down the sample. 

7.	 Store the sample on ice until you are ready to pipette the Sample Plate.

https://academy.bio-techne.com/learn
https://resources.bio-techne.com/bio-techne-assets/docs/literature/PL9-0034_RevF__SW_Buffer_Compatibility_Table.pdf
https://resources.bio-techne.com/bio-techne-assets/docs/literature/PL9-0034_RevF__SW_Buffer_Compatibility_Table.pdf
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Step 3: Prepare Your Assay Reagents

Primary Antibody

NOTES:  
Prepare enough diluted primary antibody to pipette 10 µL per well if that row will be sampled 1–2 times or 20 µL per 
well if that row will be sampled 3–4 times. 
 
The primary antibody will need to be titrated to determine the optimal dilution. We recommend starting with 1:10, 
1:50, and 1:250 dilutions. Refer to the Bio-Techne Academy for information on determining optimal primary antibody 
dilutions. 
 
An optional System Control Primary Antibody (P/N 042-196 or 042-191) can be mixed with your primary antibody in 
the assay to calculate inter-assay and inter-instrument variability.  
 
Refer to the Simple Western Antibody Database to search for commercial antibodies validated for Simple Western 
systems.

1.	 Dilute your Primary Antibody into Antibody Diluent 2. If you are using a Goat Primary Antibody with the Simple Western 
Goat Secondary Antibody, dilute your Primary Antibody with Milk-Free Antibody Diluent. 

2.	 If you’re using the System Control, dilute the System Control (10X) to 1X in your diluted Primary Antibody. 

3.	 Store the Primary Antibody on ice until you are ready to pipette the Sample Plate. 

NOTES: You can perform sized-based multiplexing in one capillary by probing for two different proteins at the same 
time. The molecular weights of the proteins you are simultaneously detecting will need to be far apart enough that 
they can be resolved from each other. For multiplexing, just dilute both Primary Antibodies into the appropriate 
Antibody Diluent. Contact Technical Support or your local Field Application Scientist to learn more. 
 
The reported molecular weight for sample proteins in Compass for Simple Western may vary from apparent 
molecular weights based on other techniques as well as sample and assay conditions.1,2

Secondary Antibody

The chemiluminescence secondary antibodies in the Simple Western Detection Kits are ready-to-use. When you're ready, 
pipette them into the Sample Plate. Store the ready-to-use secondary antibody on ice until you are ready to pipette the 
Sample Plate. 

1 Electrophoresis. 2021 Aug;42(14-15):1521-1531. doi: 10.1002/elps.202100068. 
2Electrophoresis. 2021 Feb;42(3):206-218. doi: 10.1002/elps.202000199. 

https://academy.bio-techne.com/learn
https://www.bio-techne.com/resources/simple-western-antibody-database
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NOTES:  
If you use your own HRP-labeled secondary antibody, dilute the antibody with the same Antibody Diluent used for 
your primary antibody. The secondary antibody will need to be titrated to determine the optimal dilution. Refer to the 
Bio-Techne Academy for information on determining optimal secondary antibody dilutions. 
 
Refer to the Simple Western Antibody Database to search for commercial antibodies validated for Simple Western 
systems.

Luminol-S/Peroxide

NOTE: The volume of prepared Luminol-S/Peroxide you need will depend on the number of capillary cartridges you 
are running in one run and the type of assay being performed. 

1.	 Combine Luminol-S and Peroxide in a microcentrifuge tube or conical tube according to the following table:

Assay Cartridge # Luminol-S Peroxide Total

Chemiluminescence Immunoassay
1–2 950 μL 950 μL 1900 μL

3–4 1200 μL 1200 μL 2400 μL

Chemiluminescence Immunoassay + Chemiluminescence 
Immunoassay using RePlex

1–2 1200 μL 1200 μL 2400 μL

3–4 1600 μL 1600 μL 3200 μL

Chemiluminescence Immunoassay + Total Protein 
Normalization using RePlex and Chemiluminescence Detection

1–2 1200 μL 1200 μL 2400 μL

3–4 1600 μL 1600 μL 3200 μL

2.	 Mix thoroughly by pipette or vortex. 

3.	 Store the Luminol-S/Peroxide mix on ice until you are ready to pipette the Sample Plate.

RePlex Reagent (only if performing a RePlex Assay)

The RePlex Reagent mix removes primary and secondary antibodies from the first probe so you can perform a second 
immunoassay or Total Protein assay as a second probe in a single run. 

NOTE: The volume of prepared RePlex Reagent mix you need will depend on the number of capillary cartridges you 
are running in one run. 

https://academy.bio-techne.com/learn
https://www.bio-techne.com/resources/simple-western-antibody-database
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1.	 Combine RePlex Reagent 1 and RePlex Reagent 2 in a microcentrifuge tube or conical tube according to the following 
table:

Cartridge # RePlex Reagent 1 RePlex Reagent 2 Total

1–2 960μL 240 μL 1200 μL

3–4 1760 μL 440 μL 2200 μL

2.	 Close the tube and vortex briefly. 

3.	 Store the prepared RePlex Reagent mix at room temperature until you are ready to pipette the Sample Plate. 

Total Protein Biotin Labeling Reagent (only if performing a Total Protein assay with RePlex)

The Total Protein assay enables total protein normalization within a capillary. Total Protein Biotin Labeling Reagent adds a 
biotin molecule to all the samples' proteins before detection with the Total Protein Streptavidin-HRP. 

NOTES: 
Prepare 1 tube of Total Protein Biotin Labeling Reagent if you are running 1–2 cartridges, and 2 tubes of Total Protein 
Biotin Labeling Reagent if you are running 3–4 cartridges.  
 
The Total Protein Biotin Labeling Reagent should be prepared right before pipetting it into the Sample Plate, after all 
other reagents have already been loaded on the plate.  
 
The Total Protein Streptavidin-HRP is different from the Streptavidin-HRP used for the biotinylated ladder in an 
immunoassay. 

1.	 Completely thaw the Reconstitution Reagent 1 (white cap, recommended at least 30 minutes) before preparing the Total 
Protein Biotin Labeling Reagent. Do NOT not place the tube on ice. 

2.	 Pierce the foil of the Total Protein Biotin Labeling Reagent tube with a pipette tip.

3.	 For each tube of Total Protein Biotin Labeling Reagent:

a.	 Add 150 µL of the Total Protein Reconstitution Agent 1 (white cap) to each tube of Total Protein Biotin Labeling 
Reagent.

b.	 Gently mix by pipette.

c.	 Add 150 µL of the Total Protein Reconstitution Agent 2 (orange cap) to each tube of reconstituted Total Protein Biotin 
Labeling Reagent.

4.	 Gently mix by pipette until mixed thoroughly. 

5.	 If multiple tubes were prepared, combine the Total Protein Biotin Labeling Reagent into one tube and mix by pipette. 

6.	 Load the reconstituted Total Protein Biotin Labeling Reagent on the Sample Plate immediately prior to spinning the 
plate. Do NOT place the tube on ice at any time.
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Step 4: Prepare Your Plates

Pre-filled Reagent Plate(s)

NOTES:  
You will need one Pre-filled Reagent Plate for every Capillary Cartridge used in the run.  
 
Pre-filled Reagent Plates should be stored at room temperature for at least 24 hours after receiving them before 
running an assay. 
 
The separation range for the Pre-filled Reagent Plates used in a single Leo run all must be the same.

1.	 Centrifuge the plate(s) for 5 minutes at 1000 x g (~2500 rpm) at room temperature. Perform a visual check to ensure 
liquid is fully down in all wells. 

2.	 Store the plate(s) on a flat surface at room temperature and keep the plate(s) sealed until you are ready to start your 
run. 

Sample Plate

NOTES:  
For more consistent results, keep the plate cover on the Leo Sample Plate between reagent additions and minimize 
bubble formation when adding reagents to the plate.  
 
The first capillary in the cartridge has been optimized and should only be used for running the ready-to-use 
biotinylated ladder.  
 
If a row in the Sample Plate is used for the assay, don’t leave any empty wells in the row. Fill empty wells in rows 
used in the assay with the same diluent used for the entire row. For rows filled with ready-to-use reagents, fill the 
empty wells with either Antibody Diluent 2 or Milk-free Antibody Diluent. For sample rows, fill empty wells with 
0.1X Sample Buffer.

1.	 Dispense reagents into Sample Plate wells (rows A–L, wells M1 and N1) using the volumes shown in the tables below.

2.	 Cover the plate with the plate cover and centrifuge the plate for 5 minutes at 1000 x g (~2500 rpm) at room 
temperature. Perform a visual check to ensure the liquid is fully down in all wells. 

3.	 Carefully dispense the reagents in the Sample Plate troughs (rows M–P) using the volumes shown in the tables below. 
When dispensing, move the pipette tip across the trough to ensure an even distribution and to avoid creating bubbles. 

NOTE: After reagents have been dispensed into the Sample Plate troughs, keep the Sample Plate flat during 
transport to avoid spills and prevent shifting of reagents.
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4.	 Pop any bubbles with a pipette tip.

5.	 Store the plate on a flat surface with the plate cover on at room temperature until you are ready to start your run. 

Some example plate layouts with four rows of samples are shown below. 

C H E M I LU M I N E S C E N C E I M M U N OA S S AY 

IMPORTANT: Row N must be filled with Wash Buffer and Row P must be filled with Luminol-S/Peroxide mix. 

NOTES: 
The user defines where reagents are pipetted in Rows A–L.  
 
Reagent locations will be defined in Compass for Simple Western Software before starting the run. See 
“Creating a New Assay” on page 46 for more information. Make sure to select the desired assay layout before 
adding names and attributes to the Sample Template. 

1 5 10 15 20 25
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

Well Reagent  
(Row A–L)

Sampled* 1–2 times  
(μL/well)

Sampled* 3–4 times 
(μL/well)

Biotinylated Ladder 3 3

Sample 3 3

Antibody Diluent 10 20

Primary Antibody 10 20

Secondary Antibody 10 20

Streptavidin-HRP 10 20

Well Reagent  
(M1 and N1)

1–2 Cartridges  
(μL)

3–4 Cartridges  
(μL)

Antibody Diluent 
(M1) 30 30

Wash Buffer (N1) 30 30

Cover the plate and centrifuge for 5 minutes at 1000 x g at room 
temperature

Trough Reagent 
(Row M–P)

1–2 Cartridges  
(μL)

3–4 Cartridges  
(μL)

Antibody Diluent 1500 1500

Wash Buffer 1500 1500

Luminol/Peroxide 1800 2300
*Sampled = number of times a row is used 
to load cartridges.
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C H E M I LU M I N E S C E N C E I M M U N OA S S AY + C H E M I LU M I N E S C E N C E I M M U N OA S S AY U S I N G R E P L E X:

IMPORTANT: Row N must be filled with Wash Buffer, Row O must be filled with RePlex Reagent mix, and Row P 
must be filled with Luminol-S/Peroxide mix. 

NOTES: 
The user defines where reagents are pipetted in Rows A-L. 
 
Reagent locations will be defined in Compass for Simple Western Software before starting the run. See 
“Creating a New Assay” on page 46 for more information. Make sure to select the desired assay layout before 
adding names and attributes to the Sample Template. 

The chemiluminescence immunoassay selected for Probe 1 is run first. When Probe 1 is complete, Leo performs a 
RePlex purge to remove the bound antibodies from Probe 1 before beginning the chemiluminescence immunoassay 
selected for Probe 2.

1 5 10 15 20 25
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

Probe
 1

Probe
 2

}
}

Well Reagent  
(Row A–L)

Sampled* 1–2 times  
(μL/well)

Sampled* 3–4 times 
(μL/well)

Biotinylated 
Ladder 3 3

Sample 3 3

Antibody Diluent 10 20

Primary Antibody 10 20

Secondary 
Antibody 10 20

Streptavidin-HRP 10 20

Well Reagent  
(M1 and N1)

1–2 Cartridges  
(μL)

3–4 Cartridges  
(μL)

Antibody Diluent 
(M1) 30 30

Wash Buffer (N1) 30 30

Cover the plate and centrifuge for 5 minutes at 1000 x g at room 
temperature

Trough Reagent 
(Row M–P)

1–2 Cartridges  
(μL)

3–4 Cartridges  
(μL)

Antibody Diluent 1500 1500

Wash Buffer 1500 1500

RePlex Reagent 1000 2000

Luminol/Peroxide 2300 3000

*Sampled = number of times a 
row is used to load cartridges.
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C H E M I LU M I N E S C E N C E I M M U N OA S S AY + TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G R E P L E X A N D 
C H E M I LU M I N E S C E N C E D E T E C T I O N : 

IMPORTANT: Row N must be filled with Wash Buffer, Row O must be filled with RePlex Reagent mix, and Row P 
must be filled with Luminol-S/Peroxide mix.

NOTES: 
Total Protein assay reagents are assigned to row K and L by default. You can reassign them to any location 
between rows A–L. 
 
The user defines where samples and antibodies are pipetted in Rows A–L. 
 
Reagent locations will be defined in Compass for Simple Western Software before starting the run. See 
“Creating a New Assay” on page 46 for more information. Make sure to select the desired assay layout before 
adding names and attributes to the Sample Template. 

The chemiluminescence immunoassay selected for Probe 1 is run first. When Probe 1 is complete, Leo performs a 
RePlex purge to remove the bound antibodies from Probe 1 before detecting the Total Protein assay signal in Probe 2.

1 5 10 15 20 25
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

Well Reagent  
(Row A–L)

Sampled* 1–2 times  
(μL/well)

Sampled* 3–4 times 
(μL/well)

Biotinylated Ladder 3 3

Sample 3 3

Antibody Diluent 10 20

Primary Antibody 10 20

Secondary Antibody 10 20

Streptavidin-HRP 10 20

Biotin Labeling 
Reagent 10 20

Total Protein 
Streptavidin-HRP 10 20

Well Reagent  
(M1 and N1)

1–2 Cartridges  
(μL)

3–4 Cartridges  
(μL)

Antibody Diluent 
(M1) 30 30

Wash Buffer (N1) 30 30

Cover the plate and centrifuge for 5 minutes at 1000 x g at room 
temperature

Trough Reagent 
(Row M–P)

1–2 Cartridges  
(μL)

3–4 Cartridges  
(μL)

Antibody Diluent 1500 1500

Wash Buffer 1500 1500

RePlex Reagent 1000 2000

Luminol/Peroxide 2300 3000

*Sampled = number of times a row 
is used to load cartridges.
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Step 5: Create an Assay 
Create an assay using Compass for Simple Western Software. To connect Leo to Compass, select Instrument in the main 
menu and click Connect…. Then select your instrument and click Connect. 

NOTES: 
If you are using a Wes™ system, Peggy Sue™ system, Sally Sue™ system, or NanoPro™ 1000 system, Compass for 
Simple Western version 7.0 and higher does not support these instruments. You can still use software versions 5.x 
and lower for a Peggy Sue, Sally Sue, or NanoPro 1000 and software versions 6.x and lower for Wes to create, load, 
and run assays on these systems, and to analyze data.  
 
To learn more about Compass for Simple Western, refer to the Compass for Simple Western User Guide. 

The Assay screen is used to create, view, and edit assays. To access this screen, click Assay in the screen tab:

You can run an existing assay or create a new assay. 

Creating a New Assay

To create a new assay, we recommend using one of the template assays and making any necessary modifications from 
there. 

Step 1: Open a Template Assay

1.	 Select the Assay screen.

2.	 If Leo is not connected to Compass for Simple Western, select File in the main menu, click New Assay, and select Leo. 

If Leo is connected to Compass for Simple Western, select File in the main menu and click New Assay. 

https://resources.bio-techne.com/bio-techne-assets/docs/software/Simple%20Western/CompassforSW_7.0.0/Compass%20SW%20Software%20User%20Guide.pdf
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3.	 Select the appropriate Assay Type and Size Range.

C H E M I LU M I N E S C E N C E I M M U N OA S S AY:

C H E M I LU M I N E S C E N C E I M M U N OA S S AY + C H E M I LU M I N E S C E N C E I M M U N OA S S AY U S I N G R E P L E X:

C H E M I LU M I N E S C E N C E I M M U N OA S S AY + TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G R E P L E X A N D 
C H E M I LU M I N E S C E N C E D E T E C T I O N :

4.	 Click OK.



48

Chapter 5: Running Chemiluminescence Assays   //  Starting a Run

User Guide for Leo

5.	 A template assay with default reagent locations will display in the Sample Layout pane of the Assay screen. 
The Reagent pane will display the size range selected. The Sample Layout pane example shown below is for a 
Chemiluminescence Immunoassay + Chemiluminescence Immunoassay using RePlex. 

  

Numbers on the Sample Plate indicate the row each cartridge will load reagents from. For assays using RePlex, 
reagents used in Probe 1 are labeled ‘P1’ on the plate, those used in Probe 2 are labeled ‘P2’.

NOTE: If you make changes to the assay, such as adding rows or changing the reagent assigned to a row, be sure to 
select File and Save before proceeding. 

Step 2: Assign Sample Plate Reagents

1.	 Click on the Sample Layout tab and click Assay Setup. 

2.	 Define the assay parameters.

a.	 Click the boxes next to the cartridge holder to indicate which holders will be loaded with a cartridge.

b.	 Select the number of samples, primary antibody, and secondary antibody rows pipetted on the Sample Plate using 
the drop-downs. 
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Default parameters with four rows of samples are shown. 

C H E M I LU M I N E S C E N C E I M M U N OA S S AY:

C H E M I LU M I N E S C E N C E I M M U N OA S S AY + TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G R E P L E X A N D 
C H E M I LU M I N E S C E N C E D E T E C T I O N :
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C H E M I LU M I N E S C E N C E I M M U N OA S S AY + C H E M I LU M I N E S C E N C E I M M U N OA S S AY U S I N G R E P L E X: 

A warning will appear if you try to add more rows than are allowed. 

3.	 Click Next. 
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4.	 An ‘Assay Setup - Sample Plate’ prompt will appear. Color coding is used to identify various assay reagents. 

•	 Orange – Samples and Biotinylated ladder

•	 Light Teal – Primary antibody

•	 Teal – Secondary HRP conjugate 

•	 Magenta – Antibody Diluent (2 or Milk-free)

•	 Blue – Wash Buffer

•	 Gold – Luminol-S/Peroxide mix

•	 Peach (when applicable) – Total Protein Biotin Labeling Reagent 

•	 Green (when applicable) – Total Protein Streptavidin-HRP

•	 Purple (when applicable) – RePlex Regent mix

C H E M I LU M I N E S C E N C E I M M U N OA S S AY:
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C H E M I LU M I N E S C E N C E I M M U N OA S S AY + C H E M I LU M I N E S C E N C E I M M U N OA S S AY U S I N G R E P L E X:

C H E M I LU M I N E S C E N C E I M M U N OA S S AY + TOTA L P R OT E I N N O R M A L I Z AT I O N U S I N G R E P L E X A N D 
C H E M I LU M I N E S C E N C E D E T E C T I O N :

5.	 The default protocol automatically assigns all reagent locations for the assay. 

Reagent assignments to rows M–P should not be modified. 
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6.	 Modify reagent assignments as needed for rows A–L. 

a.	 Reorder row locations by clicking on the row and dragging it to the desired location.  
 
A warning will appear if you try to move the reagent to a row that is not allowed.

b.	 Change the row a cartridge will load a sample, primary antibody, or secondary antibody from by clicking on the cell 
in the Cartridges column and typing in the cartridge number.  
 
The examples below are from setting up a Chemiluminescence Immunoassay + Chemiluminescence Immunoassay 
using RePlex assay. 
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c.	 An alert will appear at the bottom of the prompt if too many rows are assigned to one cartridge or if a cartridge is 
missing a reagent assignment. 

7.	 To add or remove a row, click the Back button and adjust the number of rows using the drop-down menus. 

8.	 Click Finish. You can also adjust the row a cartridge will load from later in the Protocol pane. 
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9.	 A Sample Plate with updated reagent locations will display in the Assay screen. Numbers on the Sample Plate indicate 
the row each cartridge will be loaded from. For assays using RePlex, reagents used in Probe 1 are labeled ‘P1’ on the 
plate, those used in Probe 2 are labeled ‘P2’. 

C H E M I L U M I N E S C E N C E 
I M M U N OA S S AY

C H E M I L U M I N E S C E N C E 
I M M U N OA S S AY + 
C H E M I L U M I N E S C E N C E 
I M M U N OA S S AY U S I N G R E P L E X

C H E M I L U M I N E S C E N C E 
I M M U N OA S S AY + TOTA L 
P R OT E I N N O R M A L I Z AT I O N 
U S I N G R E P L E X A N D 
C H E M I L U M I N E S C E N C E 
D E T E C T I O N

The Reagent pane will display the size range selected and the number of Pre-filled Reagent Plates required to 
perform your run. The Reagent pane example below is for a run using 66–400 kDa plates that is running two capillary 
cartridges. 
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Step 3: Modifying the Assay Protocol (Optional)

The capillary cartridges are all run in parallel, so voltage- and time-based parameters for all the cartridges will be the 
same. Changing the parameter for cartridge 1 will change the parameter for all other cartridges in the protocol. Grayed-out 
parameters or reagent locations cannot be changed. 

To modify the protocol:

1.	 Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to change some 
assay parameters. The example below is for a Chemiluminescence Immunoassay + Total Protein Normalization using 
RePlex and Chemiluminescence Detection Assay using 4 cartridges. 

Each row contains an assay protocol step. Each step contains a Pre-filled Reagent Plate row assignment (gray) or 
Sample Plate row assignment (color-coded) and one or more parameter settings. To view the details for a step, click on 
the gray arrow next to the step name. We recommend using default protocol settings for the assay. An expanded list of 
the default protocol step parameters is shown below: 
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NOTE: To expand all parameters, click the  button at the upper right of the pane. To collapse all parameters, click 
the  button at the upper right of the pane. 

2.	 You can change the primary or secondary antibody incubation time. 

To change the primary antibody incubation time: 

•	 Depending on the assay you’re running, click the cell next to the Primary Antibody Time (min) in the following 
column:

•	 For a chemiluminescence immunoassay: Cartridge 1 column

•	 For Probe 1 of a 2 chemiluminescence assay with RePlex: P1 Cart 1

•	 For Probe 2 of a 2 chemiluminescence assay with RePlex: P2 Cart 1

•	 Choose an incubation time from the drop-down menu. 

•	 The values for other cartridges will automatically update. 

To change the secondary antibody incubation time: 

•	 Depending on the assay you’re running, click the cell next to the Secondary Antibody Time (min) in the following 
column:

•	 For a chemiluminescence immunoassay: Cartridge 1

•	 For Probe 1 of a 2 chemiluminescence assay with RePlex: P1 Cart 1
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•	 For Probe 2 of a 2 chemiluminescence assay with RePlex: P2 Cart 1

•	 Enter a new value in minutes. 

•	 The values for the other cartridges will automatically update. 

3.	 For reagents loaded in rows A–L: You can change the row in the Sample Plate that a cartridge will load a reagent from. 
Click the cell in the column next to the Well Row and select a different row:
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NOTE: Only rows you’ve designated in the Assay Setup as the appropriate content type will appear in the drop-
down menu. 

4.	 The default Leo protocol uses a default detection profile. Exposures in the assay can be adjusted if desired. To do this, 
click the gray arrow next to Detection to expand the row. Select the Default cell in the column next to Detection Profile 
and click the … button that appears to open the Detection Profile window. 

Deselect the Default Profile checkbox. To remove times, click the Remove button. To add additional times to the 
protocol, click the Add button, enter the values, and select OK. No more than two exposures can be longer than 
32 seconds in Chemiluminescence Immunoassays and no more than one exposure per probe can be longer than 
32 seconds for RePlex assays on Leo.

NOTES:  
For a Leo Chemiluminescence Immunoassay, the Default Profile is similar to the High Dynamic Range (HDR) 
exposure series used for Jess and Abby assays but removes the 512 second exposure. For a Leo RePlex assay, the 
Default Profile is the same as the RePlex Dynamic Range (RDR) detection profile used for Jess and Abby assays. 
See the Compass for Simple Western User Guide for more information on HDR, RDR and Default detection profiles. 
 
For more information on changing protocol step parameters other than incubation times, contact ProteinSimple 
Technical Support at support@bio-techne.com (US) or Instrument.Support.EMEA@bio-techne.com (Europe). You 
can also contact your local Field Application Scientist for help.

https://resources.bio-techne.com/bio-techne-assets/docs/software/Simple%20Western/CompassforSW_7.0.0/Compass%20SW%20Software%20User%20Guide.pdf
mailto:support@bio-techne.com
mailto:Instrument.Support.EMEA@bio-techne.com
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A modified assay protocol can be exported for later use. Exporting an assay protocol exports information from the Protocol 
pane only. 

To export an assay protocol: 

1.	 Select File in the main menu and click Export Protocol…. 

2.	 The default directory is Compass for SW/Assays. Change the directory if needed. 

3.	 Enter a protocol name and click Save. The protocol will be saved as a *.protocol file. The protocol file will include the 
information in the Protocol pane (steps and row locations), but will not include information in the Sample Template 
pane. 

To import a previously saved assay protocol:

1.	 Select File in the main menu and click Import Protocol…. 

2.	 Select the *.protocol file. 

3.	 Click Open. 

Step 4: Add Assay Notes (Optional)

1.	 Click on the Notes tab.

2.	 Click in the pane and type any assay or protocol notes. This information will be stored with the assay and run data. 

NOTE: When notes are being edited, an asterisk will appear in the Notes tab to indicate changes have been made 
and should be saved. 
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Step 5: Add Sample Template Annotations (Optional)

Custom reagent names, notes, and attributes can be entered for individual rows and wells on the Sample Plate. This 
information will be stored with the assay and run data. During the post-run analysis, this information can be used to apply 
custom analysis settings specific to sample names, primary antibody and secondary antibody names, blocking reagent 
names, and/or sample, primary antibody, and secondary antibody attributes. To learn more, refer to “Analysis Settings 
Overview” in the Compass for Simple Western User Guide. 

NOTE: Template pane information can also be added or updated after a run is complete.

To enter annotations:

1.	 Click on the Sample Template tab. The default annotations for reagent rows and individual wells on the assay plate will 
be displayed. The example below is for a Chemiluminescence Immunoassay.

2.	 Change or add row and well annotations as needed. To do this:

a.	 To change the reagent name for a specific well – Select the top of the well and then either double-click, right-click 
and select Edit, click Edit in the upper right corner of the pane, or select the top of the well and press Ctrl+E. 

https://resources.bio-techne.com/bio-techne-assets/docs/software/Simple%20Western/CompassforSW_7.0.0/Compass%20SW%20Software%20User%20Guide.pdf
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Type the reagent name in the box that appears and click Enter. 

The new information will display in the selected well. 

To undo changes, press Ctrl+Z or select Undo from the Edit menu. 

b.	 To add an attribute to a specific well – Select the bottom of the well and then either double-click, right-click and 
select Edit, click Edit in the upper right corner of the pane, or select the bottom of the well and press Ctrl+E.

Type the attribute (for example, sample concentration or dilution ratio) in the box that appears and click Enter.
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The new information will display in the selected well. 

To undo changes, press Ctrl+Z or select Undo from the Edit menu. 

c.	 To change the reagent name for multiple wells – To select individual wells, press and hold the Ctrl key and then 
select the top of individual wells. To select a sequential set of wells or a full row, press and hold the Shift key, then 
select the top of the first well and last well, or hold down the left mouse button and drag the mouse across the top of 
the sequential wells you want to select. Next, either right-click and select Edit, click Edit in the upper right corner of 
the pane, press Ctrl+E, or double-click with the mouse while still holding down the Ctrl or Shift key. 

Type the new reagent name in the box that appears and click Enter.

The new information will be displayed in the selected wells. 

To undo changes, press Ctrl+Z or select Undo from the Edit menu. 
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d.	 To add an attribute to multiple wells – To select individual wells, press and hold the Ctrl key and then select the 
bottom of individual wells. To select a sequential set of wells or a full row, press and hold the Shift key, then select 
the bottom of the first well and last well, or hold down the left mouse button and drag the mouse across the bottom 
of the sequential wells you want to select. Next, either right-click and select Edit, click Edit in the upper right corner 
of the pane, press Ctrl+E, or double-click with the mouse while still holding down the Ctrl or Shift key.

Type the attribute (for example, sample concentration or dilution ratio) in the box that appears and click Enter.

The attribute information will appear in the selected wells. 

To undo changes, press Ctrl+Z or select Undo from the Edit menu. 

Custom reagent names and attributes can also be copied and pasted within Compass for Simple Western, between two 
copies of Compass, and between Compass and a spreadsheet like Microsoft® Excel®.

To copy/paste a reagent name or attribute from the Sample Template: 

1.	 Select the reagent name or attribute from the Sample Template. You can also select the reagent name and attribute for 
one or multiple cells by pressing Ctrl to select individual annotations or Shift to select sequential annotations. 

2.	 Click Ctrl+C or select Copy in the Edit menu. 
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3.	 Select the well(s) to paste the information into. 

a.	 If one well is selected, the information will be pasted sequentially. 

b.	 If individual wells are selected by pressing Shift while clicking on the wells, the information will be pasted into the 
selected cells. 

4.	 Press Ctrl+V or select Paste in the Edit menu.

NOTE: Annotations pasted into the Sample Template cannot be undone by pressing Ctrl+Z or selecting Undo in the 
Edit menu. 

To copy/paste a reagent name or attribute from Microsoft® Excel®:

1.	 Enter names in a spreadsheet row. To copy/paste names and attributes, enter names in one row and the attributes in 
the next row. 

2.	 Copy the names into the clipboard. 

3.	 Select a well in the Sample Template and paste the names from the clipboard by clicking Ctrl+V or selecting Paste in 
the Edit menu. Make sure not to select any of the ladder wells (A1, B1, C1, etc.). 
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4.	 Multiple rows can also be copied and pasted with names and attributes on alternate rows. 

NOTE: Make sure not to select any of the ladder wells (A1, B1, C1, etc.).

Sample Template information can be exported to a file. There are three file format options:

•	 A comma-separated CSV file that is best opened in a spreadsheet. 

•	 A tab-delimited TXT file that can be opened in a spreadsheet even when the decimal separator is set to a comma. 

A template can be exported from Compass for Simple Western, populated with reagent names (sample, antibody, etc.) and 
their corresponding attributes (concentration, dilution factor, etc.), in a spreadsheet like Microsoft® Excel®. 

To export and populate a Sample Template:

1.	 Click Export in the upper right corner of the Sample Template pane or select File in the main menu and click Export 
Template…. 

2.	 It is recommended to set the ‘Save as type’ to CSV. 

3.	 Enter a template name and click Save. The template will be saved as a *.csv file. 

4.	 Open the CSV file in a spreadsheet program like Microsoft® Excel®. 
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The names in the spreadsheet are arranged in the same order as the Compass Sample Template, and the rows alternate 
between names and attributes. 

NOTE: The default assay has no attributes, so these rows will be empty. 

5.	 Edit the names and add attributes, then save the spreadsheet as a CSV file. 

NOTE: Make sure not to edit the first column of the spreadsheet; this corresponds to the ladder wells. 

To import the edited CSV file into Compass for Simple Western, select File in the main menu, click Import Template…, 
or click the Import button in top right corner of the Sample Template pane and then browse to the saved .csv file. Once 
imported, the edited CSV file displays the edited reagent names and attributes in the Sample Template. 

Step 6: Save the Assay

•	 Select File from the main menu and click Save As…. 

•	 Add an assay comment (optional). 

•	 Enter the assay name and click Save.

NOTE: New assays are saved in the Compass for SW/Assays directory. 
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Opening and Modifying an Existing Assay

To open an existing assay. 

1.	 Select the Assay screen.

2.	 Select File in the main menu and click Open Assay.

3.	 A list of the last five assays opened will display. Select one of these assays or click Browse… to open the Assay folder 
and select a different assay. 

4.	 To make changes to the assay, follow the instructions under “Step 3: Modifying the Assay Protocol (Optional)” on 
page 56.

5.	 Select File from the main menu and click Save. 

Creating a Template Assay

You can create and save template assays that can be used as a starting point for creating new assays. To do this:

1.	 Select the Assay screen.

2.	 Select File in the main menu. Click Open Assay to open an existing assay or click New Assay to open an existing 
template assay.

3.	 Follow the steps in “Step 3: Modifying the Assay Protocol (Optional)” on page 56 to make changes to the assay.
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4.	 When changes are complete, select File in the main menu and click Save As. Select the New Assays folder:

5.	 Type the name for the new template assay and click Save.

6.	 Select File in the main menu and click Open Assay. The new template assay will now be available in the drop-down list:
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Step 6: Install the Cartridges and Plates

NOTES:  
Capillaries are moisture- and light-sensitive. Keep the cartridge in the sealed package until you are ready to insert 
the capillary cartridge into Leo.  
 
To prevent well evaporation and to get the best results, keep a cover on the Sample Plate until you are ready to use 
it. Once you’ve pipetted your sample and reagents into the plate, it can’t be stored for later use. 

1.	 Open the Leo system door by pushing the orange button below the door. 

NOTE: The status light on the Leo instrument front panel will blink rapidly as the door disengages. 

2.	 Swing the door open to access the capillary cartridge holders, Pre-filled Reagent Plate tray, and Sample Plate tray. The 
lights above the capillary cartridge holder(s) will be orange. 
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3.	 Remove the plate seals from the Pre-filled Reagent Plate(s).

a.	 Hold the plate firmly on the bench. 

b.	 Carefully peel off the upper seal from the top corner. 

c.	 Carefully peel off the bottom seal from the side. 

IMPORTANT:  
When removing the bottom seal, slowly remove the seals to avoid jostling liquid out of the plate or into 
adjacent wells. 

NOTE: Pop any large bubbles with a dry pipette tip.
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4.	 Place the Pre-filled Reagent Plate(s) in the Pre-filled Reagent Plate tray holders. 

a.	 A plate holder has a notch at the upper right corner and the upper left corner to ensure that the plates are placed in 
the correct orientation. 

Notch

A1 Position
Pre-filled 

Reagent Plate

NOTE: Keep the Pre-filled Reagent Plate flat during transfer to avoid spills and shifting of reagents. 

b.	 Insert the bottom of the plate first.

c.	 Push the top of the plate down. 

IMPORTANT: Make sure the Pre-filled Reagent Plates are firmly seated and level in the holders.
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5.	 Remove the capillary cartridge(s) from the packaging and insert them into the capillary cartridge holder(s). The interior 
light(s) will turn from orange to blue. 

Cartridge Shields

Cartridge Holders

NOTE: Take care not to touch the cartridge shields when installing the cartridges. 

6.	 Remove the Sample Plate cover and place the plate in the Sample Plate tray holder. The holder has a protrusion at the 
bottom center to ensure a Sample Plate, and not a Pre-filled Reagent Plate, is placed in the holder.

NOTE: Keep the Sample Plate flat during transfer to avoid spills and prevent shifting of reagents. Visually confirm 
even distribution of reagents after placement in the instrument. 

Sample Plate Tray 
Holder Protrusion
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IMPORTANT:  
Make sure the Sample Plate is firmly seated and level in the holder.

7.	 Close the Leo system door.

NOTE: Do not attempt to open the door again until the status light turns solid blue. 

8.	 After the door closes, Compass will scan the capillary cartridge(s), Pre-filled Reagent Plate(s), and Sample Plate 
barcodes to ensure the correct number are loaded and that the correct size range plates match the assay.

a.	 The status light will quickly blink blue while the instrument homes and initializes. 

b.	 The status light will slowly blink blue while the barcodes are being read.

c.	 The status light will be solid blue when Leo is done scanning the barcodes. You can now start your run. 

Step 7: Start the Assay
1.	 Click Start to start your run. You can also start a run by selecting Instrument in the main menu and clicking Start…. 

2.	 If you have modified your assay, you will be asked to save the assay before starting the run. Click Save. 
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3.	 The Start Run dialog will appear. An icon will indicate if the instrument is not ready to start run. 

•	 Door open – Close the door to start the run. 

•	 Door closed, instrument scanning cartridge and plate barcodes – Wait until the scan is complete. The status light will 
be solid blue. 

4.	 After the door is closed and the barcode scan is complete, the Start Run dialog will display the scanned barcodes or 
warn you if:

•	 Plate is expired – You have loaded a Pre-filled Reagent Plate that is past its expiration date. You will be able to start 
the run. 

•	 Cartridge is expired – You have loaded a capillary cartridge that is past its expiration date. You will be able to start 
the run. 

•	 Assay mismatch: MW – The Pre-filled Reagent Plate size range does not match the assay size range. You will be 
able to start the run. 

•	 Assay mismatch: Capillaries – You have loaded a 13-capillary cartridge that is not compatible with Leo. The 
instrument will not start if a 13-capillary cartridge is loaded. You will not be able to start the run. 

•	 Cartridge missing – No capillary cartridge is detected in a holder that should contain a cartridge based on the assay 
setup. You will not be able to start the run. 

Hover over the warning icon to learn more about the warning details. 

NOTE: If a barcode cannot be scanned, a note reminding you to confirm the cartridge or Pre-filled Reagent Plate 
matches the assay parameters will appear. 

5.	 Click in the Results file name box if you want to change the default run file name. Otherwise, just leave it as is. 

6.	 If you don’t want to save the file to the default Runs folder, click Browse… to select a different location. 

7.	 Enter any run details you’d like in the Comments box (optional). The comment will be saved in the Run Summary History 
pane. 

8.	 Click Start. 

9.	 The Status Mode next to the instrument icon will change to Running, with a progress bar indicating when the run will be 
completed, and the status light will change from steady blue to pulsing blue to let you know Leo is running. 
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Monitoring a Run

Run Summary Screen Overview
The Run Summary screen monitors run progress, displays movies of the fluorescent standards separation, and displays 
current and voltage plots for a run. Information collected is available during and after the run is completed. To access this 
screen, click Run Summary in the screen tab:

NOTE: Refer to the Compass for Simple Western User Guide to learn more about Compass Software features.

Viewing File and Run Status Information
The Barcode pane records the serial number of the Sample Plate, and serial numbers and expiration dates of the Pre-filled 
Reagent Plate(s) and capillary cartridge(s). 

Information specific to each run file is shown in the Status pane: 

The run file name, path (directory location), and assay used are displayed, along with the instrument serial number and the 
run/start complete date and time. 

•	 To go to the run file directory location - Double click the path hyperlink, or right-click and select Open Directory. 

•	 To copy the path - Right-click on the path hyperlink and click Copy Path. The path can then be copied into documents. 
The path can also be copied into the Windows Explorer address bar to launch Compass for Simple Western and open 
the run file automatically. 

•	 Kit info - Displays the type of kit used to run the assay (Regular for immunoassays and RePlex assays) and the 
molecular range.

https://resources.bio-techne.com/bio-techne-assets/docs/software/Simple%20Western/CompassforSW_7.0.0/Compass%20SW%20Software%20User%20Guide.pdf
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Each assay step that is executed during the run is represented by an icon in the Run Summary pane. The time the 
individual step is scheduled to start is shown under each icon. Details on what happens during each step are as follows: 

Step Description

Sample Loading Step - Capillary cartridge(s) are moved to the Pre-filled Reagent Plate(s) where Separation Matrix 
and Stacking Matrix are aspirated first before moving to the Sample Plate where the biotinylated ladder and 
samples are aspirated. Low vacuum is applied to filled cartridges to keep the reagents in the capillaries when other 
cartridges are being loaded. Capillary cartridges are then transferred to the running buffer trough in the Pre-filled 
Reagent Plate(s). 

Separation Step - Samples and fluorescent standards are separated in the capillaries. During the separation, 
voltage and current are monitored and displayed in the IV Plot. Separation of the fluorescent standards is recorded, 
and a movie of the separation is compiled for viewing when separation is complete in the Separation pane. 
Capillaries are then exposed to UV light, which immobilizes the separated proteins to the walls of each capillary. 
After separation, Matrix Removal Buffer is aspirated from the Pre-filled Reagent Plate(s).

Label Step (Total Protein only) - Capillary cartridges are moved to the Sample Plate and Biotin Labeling Reagent is 
aspirated. When incubation is complete, Wash Buffer is aspirated from the Pre-filled Reagent Plate(s).

Blocking Step - Capillary cartridge(s) are moved to the Sample Plate and blocking reagent (Antibody Diluent) is 
aspirated. When incubation is complete, Wash Buffer is aspirated from the Pre-filled Reagent Plate(s). 

Primary Antibody (1°) Step - Capillary cartridge(s) are moved to the Sample Plate and primary antibody is 
aspirated. When incubation is complete, Wash Buffer is aspirated from the Pre-filled Reagent Plate(s). 

Secondary Antibody (2°) Step - Capillary cartridge(s) are moved to the Sample Plate and secondary HRP 
antibody conjugate and Streptavidin-HRP is aspirated. When incubation is complete, Wash Buffer is aspirated from 
the Pre-filled Reagent Plate(s). 

HRP Step (Total Protein only) -Capillary cartridge(s) are moved to the Sample Plate and Total Protein Streptavidin-
HRP is aspirated. When incubation is complete, Wash Buffer is aspirated from the Pre-filled Reagent Plate(s). 

Detect Step - Capillary cartridge(s) are moved to the Sample Plate and Luminol-Peroxide solution is aspirated. 
Emitted chemiluminescent light is detected with the CCD camera.

Purge Step (RePlex assay only) - Capillary cartridge(s) are moved to the Pre-filled Reagent Plate(s) and Wash 
Buffer is aspirated. Cartridges are moved to the Sample Plate and RePlex Reagent mix is then aspirated to remove 
the primary and secondary antibodies from the immobilized sample proteins. The cartridges are moved back to the 
Pre-filled Reagent Plate(s) for another round of Wash Buffer. 

Results Step - Results are available in the Analysis screen.
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When a run is in progress, icons for steps that have not been executed yet will be gray (inactive). In the following example, 
the Secondary Antibody (2°) step is executing and the Detect and Results steps have not started. 

Watching Standards Separation Movies
You can view a movie of the fluorescent standards separation in the capillaries. To do this: 

1.	 Click the Separation tab. 

2.	 The player control panel has play/pause, rewind, and fast forward buttons, and a slider bar that allows you to scroll 
through the movie manually:

3.	 Click Play (button on the far left) to view the movie. 

NOTE: Complete separation movies of the fluorescent standards are not available until the separation step 
has finished executing. If the movie is playing while the separation step is executing, the movie will only show 
separation progress up to the current point in time. 
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Viewing Current and Voltage Plots
You can view plots of the total current and voltages measured during separation. To do this, click the IV Plot tab. 

The blue Y-axis and plot shows the separation voltage in volts (V), and the red Y-axis and plot shows the separation 
current in micro amps (µA). The X-axis displays the time in seconds. 

•	 To zoom in on an area of the plot - Hold the left mouse button down and draw a box around the area with the mouse. 

•	 To zoom out - Click Zoom Out in the upper right corner of the pane. 

NOTE: The IV plot for a run in progress will not be available until the separation step starts executing. The plot is 
then displayed in real-time.

Post-Run Procedures
1.	 Remove the capillary cartridge(s). 

IMPORTANT: If you turn Leo off after the run, liquid may leak out of the cartridge if left in the instrument after Leo is 
powered down. See “Shutdown” on page 32 for information on turning the instrument off.

2.	 Remove the Pre-filled Reagent Plate(s).
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3.	 Remove the Sample Plate.

4.	 Dispose of the Pre-filled Reagent Plate(s) according to your institution’s policy for disposal of reagents containing SDS. 

5.	 Dispose of the Sample Plate and capillary cartridge(s). Sample Plate and capillary cartridge disposal will depend on 
the samples that have been assayed. If sample origins are unknown, we recommend that used capillary cartridges and 
Sample Plates be disposed of as biohazard waste. 

!WARNING! SHARPS HAZARD 
The capillaries may present a potential sharps hazard. Dispose of used capillaries in biomedical waste sharps 
containers.

!WARNING! BIOHAZARD  
Samples and plates contents should be handled by procedures recommended in the CDC/
NIH manual: Biosafety in Microbiological and Biomedical Laboratories (BMBL). The manual is 
available from the U.S. Government Printing Office or online at https://www.cdc.gov/labs/bmbl/
index.html. 
 
Depending on the samples used, residual plate contents may constitute a biohazard. Dispose 
of plates in accordance with good laboratory practices and local, state/provincial and national 
environ-mental and health regulations. Read and understand the Material Safety Data Sheets 
(MSDSs) provided by the manufacturers of the chemicals in the plates before you store, handle 
or dispose of chemical waste.

Size Assay Data Analysis
Refer to the Compass for Simple Western User Guide for information on analyzing Leo data. 

https://www.cdc.gov/labs/bmbl/index.html
https://www.cdc.gov/labs/bmbl/index.html
https://resources.bio-techne.com/bio-techne-assets/docs/software/Simple%20Western/CompassforSW_7.0.0/Compass%20SW%20Software%20User%20Guide.pdf
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Overview
The Compass Access Control feature can be used to help support the 21 CFR Part 11 data security requirements when 
using Simple Western instruments. When Access Control is enabled and the Compass Authorization Server for Simple 
Western has been installed:

•	 Users are required to log in to Compass for Simple Western when the software is launched

•	 A history of all actions is maintained

•	 Data files are signed and encrypted to prevent unauthorized changes (i.e., all files are controlled)

•	 Each instrument maintains a history of user commands

•	 Each assay and data file includes a history of signed changes to the file

Compass for Simple Western Software can be run with or without Access Control enabled. When Access Control is 
disabled, no user login is required and files are not encrypted or signed. The instrument history and file history are still 
maintained but the entries are not signed.

Compass Authorization Server for Simple Western
The Compass Authorization Server (CAS) for Simple Western controls the login access to Compass for Simple Western. 
In the simplest configuration, the server is run on the same computer as Compass for Simple Western and only that copy 
of Compass for Simple Western is controlled. A single server can also be used to control access to multiple copies of 
Compass for Simple Western running on different computers, so long as they have network access to the server. Multiple 
copies of the server may be run on the same network, and each server will have its own user database.

To enable Compass for Simple Western to use a particular Authorization Server for Simple Western, click Edit, then 
Preferences and Access Control and enter the server IP address using format X.X.X.X. See “Enabling Access Control” on 
page 93 for more information. 

Server Administration

NOTES: 
Always use the default port setting of 8443, this should not be changed. 
 
If the server is installed on the same computer as Compass for Simple Western (e.g., the local machine), enter 
localhost:8443 instead of the IP address. Contact your local IT Administrator to assist with installing the Compass 
Authorization Server for Simple Western in your preferred format.

The Authorization Server for Simple Western is configured through a web interface at the IP address of the server on port 
8443. To access the Server home page, open any browser and type the IP address on port 8443 in a X.X.X.X:8443 or 
https://X.X.X.X:8443 format. Use localhost:8443 instead of the IP address if the Server is installed on the local machine.
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The default server administrator is:

•	 User: admin

•	 Password: admin

NOTE: The user account “admin” is not an active Compass for Simple Western login account. In order to log into 
Compass for Simple Western in the 21 CFR Part 11 compliant mode, at least one user account must be created in the 
Authorization Server for Simple Western application.

After installing the Compass Authorization Server for Simple Western, the administrator user name and password can be 
changed.

NOTE: Sites are responsible for maintaining their own admin and user account credentials. Record these and keep 
them safe. ProteinSimple can’t provide access once the admin account has been edited.

Adding Non-admin Users 
Add a user to the server to allow that user to log in to Compass for Simple Western. To do this: 

1.	 Select Users from the Site Administration home page:
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2.	 From the Users page, select Add User:

3.	 Fill in the fields to create a new user:
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After adding a new user more information can be added:

NOTES:  
Users are blocked after the number of login failures defined in the Password policy setting. See “Password Policy 
Settings” on page 92 for more information.  
 
Non-admin users will not be able to disable Access Control when the CAS connection is lost. 

Permissions

All users can log in to Compass for Simple Western, but the commands available within Compass for Simple Western 
are controlled by Permission settings. Commands a user does not have permission to use will be disabled. After user 
permissions have been changed on the server the user must close and re-open Compass for Simple Western to use the 
new permissions. 
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Users can belong to groups that have multiple permissions such as Operator or Scientist:

Use the Groups page to change the permissions in a group or create new groups:

To change permissions for a group click Change, then select a group:
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Move individual group permissions in or out of the Available Permissions and Chosen Permissions boxes by selecting a 
permission in either box. Click the left or right arrow button to move the permission into the other box.

Here are the current user and group permissions: 

•	 Allow analysis editing - lets users change analysis settings 

•	 Allow copy, export of data - lets users copy and export data 

•	 Allow instrument control - gives users permission to connect to an instrument 

•	 Allow plate editing - lets users update the plate layout and edit sample info 

•	 Allow protocol/method editing - gives users permission to edit protocol parameters/methods. Assay setup is allowed 
for users with this permission 

•	 Allow report printing - lets users print the run report

•	 Allow sign off of data - gives users permission to sign off on changes using e-signatures 

•	 Allow instrument administration - lets users update the instrument embedded software, delete run data from the 
instrument, update the Compass for Simple Western Software, and turn Access Control on or off

Adding Admin Users
To create a user with administrator permissions:

1.	 Follow the steps described in “Adding Non-admin Users” on page 83 to create the admin user.
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2.	 Under permissions, select Staff status and Superuser status: 

3.	 Assign the admin user to a group. 

NOTES:  
Selecting Superuser status enables server permissions only. Admin users must also be assigned to a group to in 
order to have Compass for Simple Western permissions. 
 
Only Admins will be able to disable Access Control when the CAS connection is lost. 

Resetting User Passwords

NOTE: Users are blocked after the number of login failures defined in the Password policy setting. 

To reset a user password:

1.	 Select Users from the Site Administration home page, then select the user to change. The following screen displays:
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2.	 Click the text link to access the password change form:

3.	 Enter the new password, then click Change password. 

Audit Trail
Admin users with Staff Status can view, print and download the Audit Trail. Select View Audit Trail from the Site 
Administration home page to access it. 



90

Chapter 6: Compass Access Control and 21 CFR Part 11 Compliance  //  Compass Authorization Server for Simple Western

User Guide for Leo

Here are the actions current logged in the Audit Trail:

•	 Login. User logged into CAS or Compass. 

•	 Logout. User logged out of CAS or Compass. 

•	 Start run. User started a run in Compass. Barcodes for cartridges and all plates will be logged when the run starts. 

•	 Stop run. User stopped a run in Compass. 

•	 Delete run. Run file was deleted. 

•	 Self test. User initiated a self-test on an instrument. 

•	 Open runfile. User opened a run file (*.cbz) in Compass. 

•	 Save runfile. User saved a run file (*.cbz) in Compass to the file location shown. 

•	 Save assayfile. User saved an assay file (*.assay) in Compass to the file location shown. 

•	 Instrument upgrade. User initiated an update of instrument software from Compass. 

•	 Change Control Settings. User disabled Access Control from Compass. 

•	 Generate Run Report. User generated Run Report from run in Compass. 

•	 Export spectra ANDI format. User exported the raw and analyzed data traces and background for each capillary in the 
run in .cdf format from Compass. 

•	 Export spectra text format. User exported the raw and analyzed data traces and background for each capillary in the 
run in .txt format from Compass. 
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•	 Export tables. User exported the results for all capillaries in the run in .txt format from Compass. 

•	 User created. A new user was created on CAS. 

•	 User modified. A user was modified on CAS. 

•	 User deleted. A user was deleted on CAS. 

•	 Group created. A group was created on CAS. 

•	 Group modified. A group was modified on CAS. 

•	 Group deleted. A group was deleted on CAS. 

•	 Change password. A user's password was changed. 

•	 Sign off. A user signed off on changes to the file location shown utilizing e-signatures in Compass. 

•	 Edit LDAP settings. LDAP settings in CAS were modified. 

•	 Edit password policy. Password policy settings were modified in CAS. 

•	 Install. CAS software was installed. 

•	 Upgrade. CAS software was upgraded to new version. 

•	 Blocked. A user has been blocked from logging in. 

•	 Unblock. A user has been unblocked, allowed to log in.

•	 Stop events. User initiated a stop to the instrument from Compass.

Audit Trail Settings

The Secure Audit Trail PDF setting (selected by default), allows users to download audit trail PDFs securely. Secure audit 
trail PDFs can be viewed and printed, but content cannot be copied or modified. 
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Password Policy Settings
These settings let administrators set password policies. Select Password policy settings from the Site Administration 
home page to make changes. 

LDAP Setting
LDAP settings allow you to connect the Compass Authorization Server for Simple Western to your own network’s domain 
controller, so users can log on with their existing network password. With LDAP, passwords are not maintained by the 
Compass Authorization Server for Simple Western they are administered by the network admin. 

First select LDAP settings from the Site Administration page and set your LDAP settings. 
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Next, add users as described in “Adding Non-admin Users” on page 83 and select the LDAP User checkbox. Passwords 
aren’t required for LDAP users. 

NOTE: When enabling LDAP settings, ensure the SSL port number reflects a secure LDAP port (636 recommended). 
Compass Authorization Server for Simple Western doesn’t support non-secure connections.

Encryption Details 
Compass for Simple Western uses the SHA1 hash algorithm to generate a 160-bit hash code that is unique for all files. 
All files saved by Compass for Simple Western are encrypted with a digital key. This key along with the hash codes 
guarantees the file history is correct and no other edits were made. All changes saved to a file have the electronic 
signature of the user who saved the file. The e-Signature command allows a user to sign off on a state such as approved 
or verified.

There is no individual ownership of files, all users who log into Compass for Simple Western can open any file. 

Enabling Access Control
Access Control is enabled in Preferences. Select Edit in the main menu, click Preferences, then select Access Control.
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To enable Access Control: 

1.	 Check the Enable box. 

2.	 Enter the IP address of the Compass Authorization Server for Simple Western. Use format X.X.X.X or localhost if 
installing the server on the local machine. 

3.	 Close Compass for Simple Western. The next time the software is launched, a user log in will be required. 

NOTES:  
Access Control can only be disabled by logging into Compass for Simple Western and deselecting the Enable box in 
the Access Control page of Preferences.

Changing the Software Inactivity Auto Lock
Compass for Simple Western Software automatically locks to prevent user access after a period of inactivity. Once the 
software is locked, users must log in again. Only users with instrument administrator permission can set the auto lock 
inactivity time. 

1.	 Select Edit > Preferences > Access Control. 

2.	 Enter an Auto Lock Inactivity time in minutes. The default setting is 20 minutes. 

Logging In to Compass for Simple Western
With Access Control enabled, all users must log in to Compass for Simple Western whenever the software is launched.
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Enter your username and password previously setup by your Compass for Simple Western Administrator.

NOTE: Your account will be blocked after a certain number of login failures. If this happens, contact your 
administrator to unblock the account. 

A successful log in will display the Compass for Simple Western main window with the user information in the lower status 
bar. The full username is displayed with the unique user ID in parenthesis: 

Connecting Compass to Leo Systems with Access Control Enabled
A Leo system will lock into CFR mode after you connect to the system with an instance of Compass for Simple Western 
Software that has Access Control enabled. See “Enabling Access Control” on page 93 for more information. 

Once in CFR mode, Compass will only be able to connect to the Leo instrument if Access Control is enabled. A warning will 
appear if you try to connect using an instance of Compass without Access Control enabled. This warning will not impact 
any current assay or test the instrument is in the middle of performing. 

The Leo instrument will reset so it is not in CFR mode when you turn the system off and then back on. 
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If Leo is currently running an assay or test in non-CFR mode, you will not be able to connect to the instrument with an 
instance of Compass for Simple Western with Access Control enabled. A warning will appear if this happens:

Locking and Unlocking the Application
You can click the Lock button to lock Compass for Simple Western and prevent access by other users. To unlock the 
application, users must re-enter their password. 

If there is no activity in Compass for Simple Western for 20 minutes, the application automatically locks. Users must 
re-enter their passwords to perform any controlled actions: 

NOTE: The default software inactivity lock-out time is 20 minutes. See “Changing the Software Inactivity Auto Lock” 
on page 94 for information on how to modify the lock-out timing. 
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Resolving Log In Issues
Log in failures may occur when: 

•	 The server is temporarily unavailable 

•	 Compass for Simple Western is using the wrong IP address 

When this happens, the following message displays:

U S E R:

A D M I N U S E R:

Click Disable to restart Compass for Simple Western with Access Control disabled. Verify or correct the server IP address 
then close and restart the software to log in with Access Control enabled. 
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Saving Changes
When Save is selected from the File menu, a dialog box will display to allow you to enter a comment before saving the 
signed file:

The comment is added to the signature entry in the file History:

Signing Files
Select e-Signature from the File menu to add an electronic signature to a file. 
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The signed entry will be added to the file History with the meaning of the signature entered in the comment, such as 
Approved or Verified.

Exporting Uncontrolled Files
You can export an uncontrolled file when in the Analysis screen by selecting File > Export Uncontrolled…. The export will 
also be logged in the Audit Trail and the History log for the exported file.

Instrument Command Log
The Instrument Command Log can be viewed at any time by selecting the Instrument menu and clicking Properties. Click 
the Logs button and then in the Instrument Logs box click Command Log: 
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The Command Log lists all the commands sent to the instrument that were signed by the user who sent the command. If 
you want to copy the Command Log at any time, right click in the table and select Copy, then paste into another document. 

Run File History
Select the Run Summary screen tab and then the History tab to see the file History. 

Troubleshooting Problems and Suggested Solutions
If any of the following error messages are encountered, follow the recommended steps below to resolve the issue. 

•	 Unknown username or password. 

•	 Check if the Caps Lock is on, username and password are case sensitive. 

•	 Ask a Compass for Simple Western administrator to confirm your username. If your password is unknown then the 
administrator can reset your password (see “Resetting User Passwords” on page 88 for more information).
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•	 Server not available. 

•	 From the Edit menu, click Preferences and then Access Control to confirm the server address is set to the correct 
Authorization Server for Simple Western address. Compass for Simple Western must be able to reach the server on 
the network. 

•	 Controlled file cannot be opened without log in. To open a controlled Run file, enable Access Control by clicking Edit, 
then Preferences and Access Control. Select Enable, close Compass for Simple Western, then re-launch the software 
with a valid log in. 

•	 Uncontrolled file cannot be opened when logged in. To open an uncontrolled Run file, disable Access Control by 
clicking Edit, then Preferences and Access Control. Deselect Enable, close Compass for Simple Western then re-
launch the software. 

NOTES:  
Only users with Instrument Administrator permission can turn Access Control on or off. This event will also be 
logged in the Audit Trail. 

•	 Command disabled. Certain commands are only available when a user with the correct permissions is logged in. To 
change user permissions, use a web browser to log in to the Authorization Server for Simple Western web interface at 
the address shown on the Access Control page in Preferences, such as: 127.0.0.1:8443/. 

•	 Compass for Simple Western does not prompt for login. Compass for Simple Western will only prompt for a login on 
launch when Access Control is enabled in Preferences. Enable Access Control by clicking Edit, then Preferences and 
Access Control. Select Enable, close Compass for Simple Western, then re-launch the software. You should now be 
prompted for a login.
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Software Updates
To check for software updates, first make sure the computer you’re using has an active internet connection. Then go 
to Compass for Simple Western Software, select Help in the main menu and click Check for Updates. If you don’t have 
internet access, contact ProteinSimple Technical Support for assistance on getting the latest update. 

Instrument Software (Embedded Updates)
To view the version installed, open Compass for Simple Western, select Instrument in the main menu, then click 
Properties. The current version of the system software will be displayed. 

To check for embedded updates, first make sure the computer you’re using has an active internet connection and is also 
connected to the Leo instrument. If it is not connected to Leo, go to Compass for Simple Western Software and connect to 
your instrument. Select Instrument in the main menu, then click Update and then click Network. If you don’t have internet 
access, contact Technical Support for assistance on getting the latest update.

Maintenance

Daily
Clean the Cartridge Holders and Trays: Dispose of the used capillary cartridge(s), Pre-filled Reagent Plate(s), and Sample 
Plate after each run. 

Yearly
We recommend that the Leo instrument has annual preventive maintenance performed by an authorized ProteinSimple 
representative. Please contact your Simple Western Sales Specialist or Technical Support to schedule a visit toll-free in 
the US and Canada at 1-888-607-9692. For customers in Europe, please contact Technical Support at +44 1235 529449.
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As Needed
Clean the Door Liner: Clean the door liner if you notice contaminants in the fluorescent (standards) image. Contact 
ProteinSimple Technical support to confirm contaminants if needed.

1.	 Open the Leo instrument door to reveal the door liner (glossy black finish area behind the door). 

Door Liner

2.	 Spray 70% isopropyl alcohol onto a Polyester Cleanroom line-free wipe (P/N 104-0031) or equivalent.

3.	 Carefully wipe down the door liner with the moist wipe. Avoid touching the door liner with your hands.

4.	 Wait 30 seconds for the solvent to evaporate before using Leo.

NOTE: If your instrument is failing the Self Test due to background or filter checks, clean the door liner as instructed 
above. For further assistance, contact Technical Support at support@bio-techne.com (US/Canada) or Instrument.
Support.EMEA@bio-techne.com (Europe). 

Cleaning
•	 Touch pad - Clean as needed with a soft cloth lightly moistened with dilute detergent.

•	 Drip tray, Sample Plate tray, and Pre-Filled Reagent Plate tray – Clean as needed with DI water. 

mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
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Basic Troubleshooting

Problem Solution

Leo doesn’t power on •	 Make sure the power cord is still securely plugged into the outlet and on 
the back of the instrument. 

Leo system door won’t open •	 Use the manual release button under the Leo system base at the lower left 
side to open the door. The system status should resume to normal when 
the door is closed. 

Red error light •	 Click the Reset button in Compass for Simple Western Software.

•	 Power Leo down and turn it back on. If the error persists, contact Technical 
Support at support@bio-techne.com (US/Canada) or 
Instrument.Support.EMEA@bio-techne.com (Europe).

Purple/magenta error light for more than 60 
seconds

•	 The Leo instrument can’t initialize or the hard drive has failed. Power Leo 
down and turn it back on. 

•	 If the error persists, contact Technical Support at 
support@bio-techne.com (US/Canada) or 
Instrument.Support.EMEA@bio-techne.com (Europe).

Leo won’t connect to the computer

•	 Confirm the static IP address for the ethernet port is set to 172.30.1.2.

•	 Use a direct ethernet to ethernet connection. USB to ethernet adapters can 
be unreliable.

•	 If the error persists, contact Technical Support at 
support@bio-techne.com (US/Canada) or 
Instrument.Support.EMEA@bio-techne.com (Europe).

I can’t access my data

•	 By default, the first run file will save to C:\Users\Documents\Compass for 
SW\Runs. For subsequent runs, the software will use the last location 
saved. If the last location can’t be accessed, the save path will default to 
C:\Users\Documents\Compass for SW\Runs.

•	 If you don’t see your file in the default folder, connect to Leo system’s 
embedded drive. While connected to the instrument in Compass for Simple 
Western, select Instrument > Runs...

NOTE: Run files are organized chronologically.

For Leo and Simple Western assay troubleshooting information, please contact ProteinSimple Technical Support 
toll-free in the US and Canada at (888) 607-9692, support@bio-techne.com. For customers in Europe, please 
contact Technical Support at +44 1235 529449, or Instrument.Support.EMEA@bio-techne.com. You can also visit 
https://www.bio-techne.com/resources/literature or the Bio-Techne Academy, or contact your local Field Application 
Scientist for help.

mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
https://www.bio-techne.com/resources/literature
https://academy.bio-techne.com/learn
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If the computer connected to Leo is connected to the internet, send log files directly to Technical Support through the Help 
menu using the Export Logs feature.

You can also send a run file that is open in Compass for SW Software directly to Technical Support through the Help menu 
using the Send Run File feature. 

Leo Consumables
Click here for a full list of Leo consumables.

https://www.bio-techne.com/search?keywords=simple%20western&category_attr=Simple%20Western&compatible_instrument=Leo
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Regulatory Compliance
Leo complies with: 

•	 UL 61010-1:2001: Safety requirements for electrical equipment for measurement, control and laboratory use - Part 1: 
General requirements (US) 

•	 EN 61010-1:2001: Safety requirements for electrical equipment for measurement, control and laboratory use - Part 1: 
General requirements (EU) 

•	 CAN/CSA 22.2 No. 61010-1-04: Safety requirements for electrical equipment for measurement, control and laboratory 
use - Part 1: General requirements (CA) 

•	 EN 61326-1:2013: Electrical equipment for measurement, control and laboratory use. EMC Requirements. General 
requirements (EU) 

Safety Guidelines 

!WARNING! If Leo is not used as specified by ProteinSimple, overall safety may be impaired. 

!WARNING! If Leo is damaged and doesn’t function properly, stop the instrument safely and contact ProteinSimple 
Technical Support right away toll-free in the US and Canada at 1-888-607-9692 for customers in the USA or +44 
1235 529449 for customers in Europe. 

CAUTION Avoid using Leo in ways not specified by ProteinSimple to avoid personal injuries or damage to the 
instrument. Although the instrument has been designed to protect you, this protection may not be effective if the 
instrument isn’t used properly. Only appropriated trained users should operate the system. Leo should only be 
serviced by a Bio-Techne Field Service Engineer. 
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Safety Warning Labels
The following safety labels are located on Leo instruments. Each label will display a safety alert symbol indicating a 
potential safety hazard.

Symbol Description

Risk of Electric Shock

Refer to Leo User Guide before proceeding.

Danger of hazardous waste. Use caution in these areas. This warning only applies if using 
hazardous material. Leo reagents are not considered hazardous waste. If you are using 
hazardous materials, please contact your field service representative to place labels in the 
appropriate locations.

Safe Use Specifications

Personal Protective Equipment
When operating Leo, always use the following personal protective equipment:

•	 Lab coat

•	 General purpose safety goggles

•	 Latex or nitrile gloves

NOTE: Additional PPE may be required depending on any biohazards associated with the sample. 
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Chemical Hazards

!WARNING! CHEMICAL HAZARD  
Some chemicals used can be potentially hazardous and can cause injury or illness. 

•	 Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer before you store, handle 
or work with any chemicals or hazardous materials. 

•	 Minimize contact with and inhalation of chemicals. Wear appropriate personal protective equipment when handling 
chemicals (e.g., safety glasses, gloves, clothing). For additional safety guidelines, consult the SDS. 

•	 Do not leave chemical containers open. 

•	 Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer's cleanup procedures as 
recommended by the SDS. 

•	 Comply with all local, state/provincial and national laws and regulations related to chemical storage, handling and 
disposal. 

Biohazard Waste

!WARNING! BIOHAZARD  
Samples and plates contents should be handled by procedures recommended in the CDC/
NIH manual: Biosafety in Microbiological and Biomedical Laboratories (BMBL). The manual is 
available from the U.S. Government Printing Office or online at https://www.cdc.gov/labs/bmbl/
index.html. 
 
Depending on the samples used, residual plate contents may constitute a biohazard. Dispose 
of plates in accordance with good laboratory practices and local, state/provincial and national 
environ-mental and health regulations. Read and understand the Material Safety Data Sheets 
(MSDSs) provided by the manufacturers of the chemicals in the plates before you store, handle 
or dispose of chemical waste.

•	 Read and understand the Safety Data Sheets (SDSs) provided by the manufacturers of the chemicals in a waste 
container before you store, handle or dispose of chemical waste. 

•	 Minimize contact with chemical waste. Wear appropriate personal protective equipment when handling chemicals (e.g., 
safety glasses, gloves, clothing).

https://www.cdc.gov/labs/bmbl/index.html
https://www.cdc.gov/labs/bmbl/index.html
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Safety Data Sheets
Some chemicals used with Leo may be listed as hazardous. Warnings are displayed on the labels of all chemicals when 
hazards exist. 

Safety Data Sheets (SDSs) provide users with safety information needed to store, handle, transport and dispose of the 
chemicals safely. We recommend updating laboratory SDS records periodically. 

SDSs for ProteinSimple reagents are available online on the reagent specific webpage, or by calling toll-free in the US and 
Canada 1-888-607-9692. Otherwise, call the chemical manufacturer directly or visit their web site.

Surface Decontamination
All assay steps are performed and contained within the capillary cartridge. Unless there is a spill, no surface 
decontamination is required. 

Always consult the SDS for specific information on the chemical before attempting cleanup.

NOTES: 
Do not use bleach to clean the instrument.  
  
Contact your Field Service Engineer if you need to decontaminate the cartridge shield or cartridge holder. 

Transport
Do not attempt to move Leo yourself. Contact your Field Service Engineer for support. 
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Customer Service and Technical Support
Telephone

(408) 510-5500 

(888) 607-9692 (toll-free in the US and Canada) 

+44 1235 529449 (Europe)

Fax

(408) 510-5599

E-mail

US - support@bio-techne.com

Europe - Instrument.Support.EMEA@bio-techne.com

Web

https://www.bio-techne.com/instruments/simple-western

Address

ProteinSimple 

3001 Orchard Parkway

San Jose, CA 95134

USA

mailto:support%40bio-techne.com?subject=
mailto:Instrument.Support.EMEA%40bio-techne.com?subject=
https://www.bio-techne.com/instruments/simple-western
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Legal Notices

 NOTE: Read the Legal Notices carefully before using Leo.

Leo Disclaimer of Warranty 
EXCEPT AS EXPRESSLY PROVIDED IN ANY ProteinSimple SOFTWARE LICENSE AGREEMENT OR QUOTATION, THE PRODUCTS SOLD 
AND SERVICES PROVIDED BY ProteinSimple ARE PROVIDED ON AN “AS IS” AND “AS AVAILABLE” BASIS WITHOUT WARRANTY OF ANY 
KIND. ProteinSimple AND ITS SUPPLIERS DO NOT WARRANT THE SECURITY, PRIVACY OR ACCURACY OF ANY DATA PROVIDED VIA THE 
PRODUCTS OR SERVICES, AND YOU AGREE THAT THE USE OF ANY SUCH DATA BY YOU IS AT YOUR SOLE RISK. TO THE MAXIMUM 
EXTENT ALLOWED UNDER APPLICABLE LAW, ProteinSimple AND ITS SUPPLIERS DISCLAIM ANY AND ALL WARRANTIES, WHETHER 
EXPRESS, IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, TITLE, NON-
INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. 

Compass for Simple Western Software and Authorization Server License
IMPORTANT - PLEASE READ CAREFULLY THE TERMS OF THIS COMPASS SOFTWARE AND AUTHORIZATION SERVER LICENSE 
AGREEMENT (“AGREEMENT”). BY CLICKING ON THE “I AGREE” BUTTON, (1) YOU ACKNOWLEDGE THAT YOU HAVE READ, UNDERSTAND 
AND AGREE TO BE BOUND BY THIS AGREEMENT AND (2) YOU REPRESENT THAT YOU HAVE THE AUTHORITY TO ENTER INTO THIS 
AGREEMENT, PERSONALLY OR IF YOU HAVE NAMED A COMPANY AS CUSTOMER, ON BEHALF OF THAT COMPANY (YOU OR ANY SUCH 
COMPANY, THE “CUSTOMER”), AND TO BIND THE CUSTOMER TO THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL 
TERMS AND CONDITIONS OF THIS AGREEMENT, OR IF YOU DO NOT HAVE SUCH AUTHORITY, YOU SHOULD CLICK ON THE “CANCEL” 
BUTTON TO DISCONTINUE THE DOWNLOAD OF THE LICENSED SOFTWARE.

1.	 Definitions

1.1.	 “Authorized Use Parameters” means the following usage restrictions, which restrict the operation of the Licensed Software 
to a particular set of conditions: Customer shall (a) limit simultaneous use of the Licensed Software to a maximum of ten (10) 
Authorized Users; and (b) use the Licensed Software only in connection with the accompanying System purchased by Customer 
pursuant to the System Quotation and located at the Site.

1.2.	 “Authorized User” means one (1) User who initiates the execution of the Licensed Software and/or interacts with or directs 
the Licensed Software in the performance of its functions. Multiple Authorized Users may work simultaneously with one 
installation of the Licensed Software, as on a server, or they may each have their own installation on single-user machines, or a 
mix of these, provided that in all cases the total number of simultaneous Users does not exceed the applicable Authorized Use 
Parameters.

1.3.	 “Company” means ProteinSimple. 

1.4.	 “Documentation” means Company's then-current manuals, guides and online help pages, if any, applicable to the Licensed 
Software and made generally available by Company to its customers.

1.5.	 “Enterprise” means those organizations that have Internet addresses located at top level and second-level domain names set 
forth in the System Quotation. 

1.6.	 “Error” means a reproducible error in the Licensed Software that prevents such Licensed Software from operating substantially 
in accordance with its Documentation.
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1.7.	 “Executable Code” means the fully compiled binary version of Licensed Software that can be executed by a computer and used 
by an end user without further compilation.

1.8.	 “Intellectual Property Rights” means all copyrights, trade secrets, patents, patent applications, moral rights, contract rights 
and other proprietary rights, but specifically excluding any trademarks or service marks. 

1.9.	 “Licensed Software” means the Compass for Simple Western software program in Executable Code form, and any Updates that 
Company makes available to Customer in accordance with this Agreement.

1.10.	“Site” means the facility or campus set forth in the System Quotation.

1.11.	 “System” means the proprietary NP1000, NP100, Simon, Sally, Peggy, Wes, Jess, Abby, Leo, Sally Sue and Peggy Sue protein 
analysis system or any future model or successor thereto that is provided to Customer by Company pursuant to a separate 
agreement between the parties (the “System Quotation”).

1.12.	“Update” means those releases of the Licensed Software that Company provides to customers to correct Errors, fix bugs, or 
create minor improvements, incremental features or enhancements of existing features which Company designates by a change 
in the number to the right of the first or second decimal point. Updates do not include those releases of the Licensed Software 
that provide substantial new features or additional functionality which Company designates by a change in the number to the 
left of the first decimal point.

1.13.	“User” means any individual that has an e-mail address within the Enterprise.

2.	 License and Restrictions

2.1.	 License Grant. Subject to the terms and conditions of this Agreement and the payment of the required fees set forth in the 
System Quotation, Company grants to Customer a nontransferable, nonexclusive, royalty-free, revocable, worldwide license 
(without the right to sublicense) to (a) install the Licensed Software on any computer located at any Site; (b) use, execute and 
display the Licensed Software, in Executable Code form only; and (c) copy the Licensed Software and Documentation, solely 
as necessary to support Authorized Users; in each of the foregoing, solely in accordance with the Documentation and the 
Authorized Use Parameters. Customer agrees that it will comply with the Authorized Use Parameters.

2.2.	 License Restrictions. Customer acknowledges that the Licensed Software and its structure and organization constitute 
valuable trade secrets of Company. Accordingly, the license granted in this Agreement is subject to the following restrictions: 
Customer and its Authorized Users (a) may not reverse engineer, disassemble, decompile or otherwise attempt to derive the 
source code of Licensed Software; (b) may not modify, adapt, alter, translate or create derivative works from the Licensed 
Software; (c) may not merge the Licensed Software with other software; (d) may not use the Licensed Software in any service 
bureau or time-sharing arrangement, license, sell, rent, lease, transfer, assign, distribute, host, outsource, disclose or otherwise 
commercially exploit or make the Licensed Software or Documentation available to any third party; (e) shall only make that 
number of exact copies of the Licensed Software and Documentation as delivered by Company that are necessary to support 
Customer's use of the Licensed Software in accordance with this Agreement; (f) shall include any titles, trademarks and 
copyright and restricted rights notices that are included on or in the Licensed Software as delivered by Company on and in 
any copies of the Licensed Software that it makes; and (g) shall ensure that Customer's use of the Licensed Software does not 
exceed the scope of the license that Customer has purchased pursuant to this Agreement.

2.3.	 Open Source Software. Certain items of independent, third-party code may be included in the Licensed Software that are 
subject to open source licenses (“Open Source Software”). Such Open Source Software is licensed under the terms of the 
license that accompanies such Open Source Software. Nothing in this Agreement limits Customer's rights under, or grants 
Customer rights that supersede, the terms and conditions of any applicable end user license for such Open Source Software. In 
particular, nothing in this Agreement restricts Customer's right to copy, modify and distribute such Open Source Software that is 
subject to the terms of such open source licenses.

2.4.	 Ownership. Company reserves all rights not expressly granted to Customer in this Agreement. Without limiting the generality 
of the foregoing, Customer acknowledges and agrees that, except as expressly set forth in this Agreement, Company and its 
suppliers retain all Intellectual Property Rights, title and interest in and to the Licensed Software and Documentation.
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3.	 Support and Maintenance Services

3.1.	 Services. Subject to Customer's payment of the Services fees, as set forth in the System Quotation, and to the terms and 
conditions herein, Company will use commercially reasonable efforts to provide to Customer the following support and 
maintenance services (the “Services”) for the Licensed Software: (a) Company will answer technical questions concerning 
functions and features of the Licensed Software; (b) Company will provide Error verification, analysis and corrective efforts 
for the Licensed Software; and (c) Company will provide, without charge, Updates of the software released during the 
term of this Agreement. Customer will be responsible for providing, in a manner consistent with good industry practice, all 
Services to Users. Customer acknowledges that Company may not be able to correct all reported Errors. Any Update of the 
Licensed Software will be deemed part of the Licensed Software and Customer will use such Updates in accordance with the 
requirements and obligations in this Agreement.

3.2.	 Service Conditions. Company's obligation to provide the Services is conditioned on Customer: (a) notifying Company of any 
Error within a reasonable period of time; (b) providing Company all information relating to the Error; (c) providing access to the 
Licensed Software and Customer's facility where the Licensed Software is located and informing Company of any potential 
hazards which may be encountered while servicing the Licensed Software. Customer may contact Company via telephone 
toll-free in the US and Canada 1-888-607-9692 or e-mail at support@bio-techne.com during the hours of 8:00 AM (Pacific 
Time) and 5:00 PM (Pacific Time) Monday through Friday, excluding holidays, to report any Error. A list of standard holidays will 
be provided to Customer upon request. Company shall have the right to determine in its sole discretion what corrective action 
Company will perform to support the Licensed Software. Company may subcontract the Services to a third party contractor 
provided that Company will be responsible for the third party contractor's compliance with this Agreement. 

3.3.	 Service Exclusions. Company will not be obligated to provide the Services if (a) Company determines that an Error is caused by 
malfunction of any hardware (other than malfunction of the System) or third party software used with the Licensed Software; or 
(b) Customer has failed to incorporate the latest Update previously released to Customer. 

4.	 Warranty

4.1.	 Licensed Software Warranty. Company warrants that the Licensed Software, as properly installed, and under normal use, will 
perform substantially in accordance with its Documentation during the Warranty Period. The “Warranty Period” for the Licensed 
Software begins on date Customer downloads the Licensed Software and ends twelve (12) months thereafter.

4.2.	 Remedy. If Customer notifies Company in writing during the Warranty Period of an Error, Company will, at its expense and as its 
sole obligation for any breach of the foregoing warranty, use commercially reasonable efforts to correct the Error or replace the 
Licensed Software. Any Error correction or replacement of the Licensed Software will not extend the original Warranty Period. 
The warranty and the remedies provided above will not apply to the Licensed Software if (a) Company determines that an Error 
is caused by accident, abuse, misuse, negligence, fire, earthquake, flood, other force majeure event, failure of electrical power, 
the use of unauthorized products or unauthorized repairs or modifications; (b) Company determines that an Error is caused 
during or as a result of delivery; (c) a problem arises from or is based on Company's compliance with Customer's specifications; 
or (d) Company determines that an Error is caused by malfunction of any hardware (other than malfunction of the System) or 
third party software used with the Licensed Software.

4.3.	 Disclaimer. THE WARRANTIES ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, WHETHER EXPRESS, 
IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR 
A PARTICULAR PURPOSE, TITLE AND NONINFRINGEMENT. 

5.	 Limitation of Liability. NEITHER COMPANY NOR ITS SUPPLIERS SHALL BE RESPONSIBLE OR LIABLE WITH RESPECT TO ANY 
SUBJECT MATTER OF THIS AGREEMENT OR TERMS OR CONDITIONS RELATED THERETO UNDER ANY CONTRACT, NEGLIGENCE, 
STRICT LIABILITY OR OTHER THEORY (A) FOR LOSS OR INACCURACY OF DATA, LOSS OF PROFITS OR COST OF PROCUREMENT 
OF SUBSTITUTE GOODS, SERVICES OR TECHNOLOGY, OR (B) FOR ANY INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
INCLUDING, BUT NOT LIMITED TO LOSS OF REVENUES AND LOSS OF PROFITS. COMPANY'S AGGREGATE CUMULATIVE LIABILITY 
HEREUNDER SHALL NOT EXCEED THE GREATER OF FIVE HUNDRED DOLLARS ($500.00). 

6.	 Term and Termination

6.1.	 Term of Agreement. The Agreement is effective on the date Customer downloads the Licensed Software and shall remain in 
effect until terminated by either party as provided in this section. 

mailto:support%40bio-techne.com?subject=
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6.2.	 Termination For Material Breach. Either party may terminate this Agreement upon written notice if the other party materially 
breaches this Agreement and fails to cure such breach within thirty (30) calendar days following receipt of written notice 
from the other party specifying the breach in detail. Notwithstanding the foregoing, Company may immediately terminate 
this Agreement and all licenses granted hereunder if Customer breaches Section 2 (License and Restrictions) hereof or upon 
termination of the System Quotation. The foregoing rights of termination are in addition to any other rights and remedies 
provided in this Agreement or by law.

6.3.	 Effect of Termination. Upon termination of this Agreement (or termination or expiration of any license granted hereunder), 
all rights of Customer to use the Licensed Software and Documentation will cease and (a) all license rights granted under this 
Agreement will immediately terminate and Customer shall promptly stop all use of the Licensed Software and Documentation; 
(b) all Services will terminate immediately; (c) Customer shall promptly erase all copies of the Licensed Software from 
Customer's computers, and destroy all copies of the Licensed Software and Documentation on tangible media in Customer's 
possession or control or return such copies to Company; and (d) upon request by Company, Customer shall certify in writing 
to Company that it has returned or destroyed such Licensed Software and Documentation. The parties' rights and obligations 
under Sections 1 (Definitions), 2.4 (Ownership), 4.3 (Disclaimer), 5 (Limitation of Liability), 6 (Term and Termination), and 7 
(General) shall survive termination of this Agreement.

7.	 General

7.1.	 Assignment. This Agreement and Customer's rights hereunder may not be assigned to any third party by Customer except with 
the prior written approval of Company. Any attempted assignment of this Agreement or any rights or obligations hereunder will 
be null and void. 

7.2.	 Governing Law. This Agreement is made in, governed by, and shall be construed in accordance with the laws of the State of 
California, without regard to any conflicts of law principles that would result in application of laws of any other jurisdiction. The 
United Nations Convention on Contracts for the International Sale of Goods does not apply to this contract. Any legal action 
or other legal proceeding relating to this contract or the enforcement of any provision of this contract must be brought in any 
state or federal court located in Santa Clara County, California. Customer and Company expressly and irrevocably consents and 
submits to the jurisdiction of such courts. 

7.3.	 Injunctive Relief. Customer acknowledges that the Licensed Software contains valuable trade secrets and proprietary 
information of Company, that any actual or threatened breach of this Agreement will cause harm to Company for which 
monetary damages would be an inadequate remedy, and that injunctive relief is an appropriate remedy for such breach. 

7.4.	 Modifications. Company reserves the right to change the terms and conditions of this Agreement or its policies relating to 
the Licensed Software at any time. Company will notify Customer of any material changes to this Agreement by sending 
Customer an e-mail to the last e-mail address Customer provided to Company or by prominently posting notice of the changes 
on Company's website. Any material changes to this Agreement will be effective upon the earlier of thirty (30) calendar days 
following Company's dispatch of an e-mail notice to Customer or thirty (30) calendar days following Company's posting of 
notice of the changes on Company's website. These changes will be effective immediately for new users of our Licensed 
Software. Please note that at all times Customer is responsible for providing Company with its most current e-mail address. 
In the event that the last e-mail address that Customer has provided Company is not valid, or for any reason Company is not 
capable of delivering to Customer the notice described above, Company's dispatch of the e-mail containing such notice will 
nonetheless constitute effective notice of the changes described in the notice. If Customer does not agree with the changes to 
this Agreement, Customer must notify Company prior to the effective date of the changes that Customer wishes to terminate 
its license to the Licensed Software. Continued use of the Licensed Software, following notice of such changes, shall indicate 
Customer's acknowledgment of such changes and agreement to be bound by the terms and conditions of such changes. 

7.5.	 Severability. In the event any provision of this Agreement is held to be invalid or unenforceable, the remaining provisions of this 
Agreement will remain in full force.

7.6.	 Waiver. The waiver by either party of any default or breach of this Agreement shall not constitute a waiver of any other or 
subsequent default or breach. 

7.7.	 Export. Customer agrees not to export, reexport or transfer, directly or indirectly, any U.S. technical data acquired from 
Company, or any products utilizing such data, in violation of the United States export laws or regulations.
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North America    TEL 800 343 7475   
Europe  //  Middle East  //  Africa    TEL +44 (0)1235 529449 
China    info.cn@bio-techne.com, TEL 400.821.3475

For research use or manufacturing purposes only. Trademarks and registered trademarks are the property of their respective owners. 

Global Developer, Manufacturer, and Supplier of High-Quality Reagents, 
Analytical Instruments, and Precision Diagnostics.

INCLUDES     R&D Systems™ Novus Biologicals™ Tocris Bioscience™ ProteinSimple™ ACD™ ExosomeDx™ Asuragen® Lunaphore™

7.8.	 Force Majeure. Company shall not be liable, directly or indirectly, for any delay or failure in performance of any obligation under 
this Agreement, including any delivery obligation, where such delay or failure arises or results from a cause beyond Company's 
reasonable control, or beyond the reasonable control of Company's suppliers or contractors, including, but not limited to strike, 
boycott or other labor disputes, embargo, governmental regulation, inability or delay in obtaining materials, acts of God, war, 
earthquake, fire or flood. In the event of such force majeure, the time for delivery or other performance will be extended for a 
period equal to the duration of the delay caused thereby, provided that Company notifies Customer of the nature and duration of 
such force majeure event. 

7.9.	 Entire Agreement; Notice. This Agreement constitutes the complete agreement between the parties and supersedes all prior or 
contemporaneous agreements or representations, written or oral, concerning the subject matter of this Agreement. Except as 
otherwise expressly provided in this Agreement, any modifications of this Agreement must be in writing and agreed to by both 
parties. Company may provide any notice to Customer by e-mail. Customer may provide notice to Company by sending an e-mail 
to info@biotechne.com or a letter by United States mail to ProteinSimple, 3001 Orchard Parkway, San Jose, CA 95134, or to such 
other address as Company may specify in writing by posting the new address on the Company website.

7.10.	Relationship of the Parties. The parties are acting hereunder as independent contractors and not as partners, agents, fiduciaries 
or joint venturers. Neither party has the power or authority represent, act for, bind or otherwise create or assume any obligation 
on behalf of the other party.

mailto:info%40biotechne.com?subject=
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